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1 OVERVIEW 

1.1 Introduction 

This manual describes the Scienta Omicron spectrometer software SES version 1.8.0 

The SES software is a Windows-based application that manages the user interaction with the 
Scienta Omicron hemispherical spectrometers, except models within the Argus and Sphera series. 
The SES software controls the spectrometer electronics, and provides a plug-in interface for 
auxiliary equipment. 
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1.3 History 

Version Date Edited by Description 

1.9 2010-08-17 MWi First version derived from version 1.8 of printed 
software section in user manual 

1.10 2012-03-30 MLq, 
MWi 

Application examples added in Installation section. 
A section describing the progress bar for swept 
mode acquisitions added. 

1.11 2012-10-22 MLq New front pages, headers and footers 

1.12 2013-08-22 JJo Added the VG Manipulator user guide. 

1.21 2013-09-01 MLq Manipulator scan and other run modes and special 
region info added. The word frame is replaced by 
section where applicable. 
Manipulator Installation chapter revised 

2.0 2014-03-14 MLq Cosmetic changes 
The whole structure made generic for easy 
expansion of new run modes etc. Manipulator and 
Monochromator information extracted and moved 
to dedicated sections. 

3.0 2016-04-21 MLq Scienta Omicron first pages, headers and footers 

4.0 2018-04-20 MLq Major facelift. 
Sections about MCP calibration, 
MCP voltage optimization, sequence start, element 
set selection, DAC.ini file format, installation, 
backup, libs, Detector Graph added 
Text non-applicable to version 1.8.0 removed 
Dialog figures changed to 1.8.0 versions 

4.1 2018-05-07 MLq Minor changes 

5.0 2018-05-22 MLq Document name changed from SES Software 
User’s Guide to SES Software Manual 
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2 GENERAL DESCRIPTION 

2.1 Introduction 

This section describes the system requirements, the recommended access control set-up and how 
to get started in the software. 

2.2 About the Software 

2.2.1 System Requirements 

The SES software version 1.8.0 is developed and tested for Windows 10. Earlier versions down 
to 1.3.0 operate under Windows 7 and the older 1.2.0 generation operates under Windows XP. 
The performance of the computer that comes with each Scienta Omicron spectrometer is 
selected to match the spectrometer model. For example, a DA30 computer is more powerful 
than an R3000 computer. For further information about system requirements, contact Scienta 
Omicron. 

2.2.2 Access Control 

The software enables a strict access control to sensitive calibration data by enabling a Privilege 
Level mechanism for individual voltage elements. The three levels available are: Administrator, 
Privileged User and User. The level is determined from the current Windows account, and the 
element access level is configured from the Element Installation dialog. 

2.3 Installation 

2.3.1 Description 

This section gives an overview of how to download and install the SES software. 

2.3.2 Procedure 

1. Download a SES software package zip-archive from the Scienta Omicron FTP server 
(ftp://ftp.scienta.se). The packages denoted “Win32” and “Win64” are designed for 32 
bit and 64 bit Windows respectively. 

2. Extract the zip-archive to a folder on a local disc drive in the PC.  

3. Copy the complete SES folder (named SES + version number + Win32/64) from the 
package to a folder where the new SES version will recede. 

4. Open the \Examples\SES_DA_Template or the \Examples\SES_Template folder 
in the SES package depending on the spectrometer model. The first folder contains the 
files for the DA30 spectrometer family and the second one is for all other spectrometer 
models. 

5. Copy the complete \ini, \data, and \sequences folders to the new SES folder. 

2.4 Configuration 

2.4.1 Description 

This section gives an overview of how to configure the SES software for the first time after 
installation when parameters from an old SES installation do not exist. The libraries mentioned in 
the procedure are further described in the Library section below. 

ftp://ftp.scienta.se/
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2.4.2 Procedure 

1. Start the new SES program. 

2. Open the Instrument Installation dialog (Installation  Instrument…) 

3. Browse and select a detector interface library that is valid for the detector of choice. 

4. Make the necessary detector setup settings. 

5. Browse and select a supply interface library that is valid for the HV cabinet 
communication of choice. 

6. Make the necessary supply setup settings. 

7. In the case of spin detectors or other external signal input/output applications, browse 
and select an appropriate external I/O interface library that is valid for the input/output 
signal hardware of choice. 

8. Make the necessary external I/O setup settings. 

9. Open the Options dialog (File  Options…) and set the SES options. 

10. In the case of DA30 analysers, add the user interface Lualib from the User Interface 
dialog. 

11. Restart SES. No error messages should appear when the detector, supply and external 
I/O communication works. 

12. If the supply list does not match the hardware configuration, make the necessary changes 

from the Supply Installation dialog. (Installation  Supplies…) 

13. If the element set definitions do not match the hardware configuration, make the 

necessary changes from the Element Installation dialog (Installation  Elements…). 

14. If supply calibration data is missing, enter it manually from the Supply Installation dialog, 
or exit the SES program and import it to the instrument file using the a special 
configuration program (SES Configure). Please contact Scienta Omicron for support. 

15. If DAC calibration data is missing, exit the SES program and enter it manually in the 
DAC.ini file or use the special configuration program (SES Configure) for creation of a 
new DAC.ini. Please contact Scienta Omicron for support. 
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2.5 Upgrade 

2.5.1 Description 

This section gives an overview of how to upgrade old SES software to a later version. 

2.5.2 Procedure 

1. Make a backup of the old SES installation (see section below). 

2. If the upgrade starts from a recent revision of the SES program, copy and overwrite the 
full content of the ini, data, and sequences folder (containing all settings and calibration 
parameters for the spectrometer) from the old installation to the new one. 
In the case of older versions, the library structures and data formats might be 
incompatible that require a special configuration program (SES Configure) for the 
upgrade. Please contact Scienta Omicron for support. 

3. Start the new SES program and check that all features from the old installation works. 
Please contact Scienta Omicron for support if a new SES program in combination with 
old data files show strange behavior. 

2.6 Backup 

2.6.1 Description 

This section gives an overview of how to do backup of the SES software. 

2.6.2 Procedure 

The easiest method of doing backup is to regularly save copies of the whole SES folder 
(excluding the experiment data). If this method is used, make sure that no files are inadvertently 
write-protected when restoring the backup. 
Another way to do backup in order to save disk space is to save copies of the unique settings and 
calibration parameter files only. The SES sub-folders of importance are stated in the table below. 

Table 1: SES sub-folders. 

Sub-folder Files Comment 

/data *.dat 
*.bin 

Instrument parameters in binary format 
Camera image background maps 

/data/lenstables *.txt 

*.bin 

Lens tables in text format 
Lens tables in binary format 

/ini *.ini 
*json 

Instrument settings in SES text format. 
Instrument settings in JSON text format. 

/sequences *seq 
*.ini 

Definition of the sequence of regions in text format 
Pointer to the seq-file in text format 
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2.7 Libraries 

2.7.1 Description 

This section describes the fundamental libraries that are installed when setting up basic 
spectrometer functionality. The library files are found in the corresponding /dll sub-folders of 
the SES software. 

2.7.2 Library List 

Table 2: SES libraries. 

Library File Description 

Detector_Graph.dll Main library for camera detectors 

CameraBasler.dll Plug-in library to Detector_Graph for 
Basler cameras 

CameraDummy.dll Plug-in library to Detector_Graph for 
generic camera simulation 

Detector_Dummy.dll Main library for generic camera 
simulation (old version) 

Supply_HVC20.dll Main library for HV cabinet 
communication 

HWDI_Network1.dll Plug-in library to Supply_HVC20 for 
Ethernet communication 

HWDI_Serial1.dll Plug-in library to Supply_HVC20 for 
COM port communication 

Supply_Dummy.dll Main library for HV cabinet simulation 

Supply_7048_Serial.dll Main library for HV cabinet 
communication (old version) 

ExternalIO_NIDAQ.dll Main library for signal input/output via 
National Instrument hardware 

ExternalIO_NIDAQ_Dummy.dll Main library for signal input/output 
simulation 

Lua_lib.dll User interface library for DA30 
applications 

Luafs.dll File interface library for DA30 
applications 
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3 GETTING STARTED 

3.1 Starting Program 

The SES program is started by double-clicking on its icon. A click sound from the High Voltage 
should be noticeable. 

3.2 Check Cables for Low or High Pass 

The SES program begins with a pop-up window that reminds you to check cable connections for 
either Low Pass or High Pass. 

3.3 Prior Acquisition 

If the SES program has inadvertently shut down during prior acquisition and there is still usable 
data in the work folder, a query to save the data to an experiment file before continuing is 
displayed. Click Yes or No to continue. 

3.4 Start Guide  

 Experiments are defined via Setup in the Sequence menu (Sequence  Setup) 

 Experiments are started by Run in the Sequence menu (Sequence  Run) 

 Energy calibration and lens deflection calibration is done in the Voltage Calibration dialog 

(Calibration  Voltages). 

 Global detector parameters are set via Global Detector in the Setup menu (Setup  
Global Detector). 

3.5 Before Turning HV On 

 Make sure the pressure is below 110-5 mbar. 

 Open the Voltage Calibration dialog to check that the running parameters, especially the 

MCP and Screen voltages, are reasonable (Calibration  Voltages). 

3.6 SES Menu Bar 

3.6.1 Introduction 

This section gives an overview of the features and functions that are accessed from the SES 
menu bar (the main menu of SES). 
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3.6.2 File Menu 

 

Figure 1: File Menu 

3.6.2.1 File Menu Items 

Table 3: File menu items. 

Menu Item Description 

Open Spectrum... Open a previously saved spectrum, which is 
then displayed in a separate window. 

Save Spectrum... Save an open spectra 

New Instrument Create a new instrument calibration file 

Open Instrument... Open a different instrument calibration file 

Save Instrument As... Save the currently open instrument calibration 
file under a different name 

Reset Abort ongoing acquisition and send a reset to 
the supply and the detector hardware 

Zero Supplies Set all supplies to zero voltage 

Options... Open the SES Options dialog 

Exit Close the SES program 

3.6.3 View Menu 

 

Figure 2: The View menu. 
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3.6.3.1 View Menu Items 

Table 4: View menu items. 

Menu Item Description 

Error List Show the error listing 

Sequence Tree Show the sequence tree when the spectrum 
display is shown 

Show Supply Information... Open the Supply Information window 

Show Detector Information... Open the Detector Information window 

3.6.4 Installation Menu 

 

Figure 3: The Installation menu 

3.6.4.1 Installation Menu Items 

Table 5: Installation menu items. 

Menu Item Description 

Instrument... Open the Instrument Installation dialog 

Supplies... Open the Supply Installation dialog 

Elements... Open the Element Installation dialog 

Lens Modes... Open the Lens Mode Installation dialog 

3.6.5 Setup Menu 

 

Figure 4: The Setup menu. 

3.6.5.1 Setup Menu Items 

Table 6: Setup menu items. 
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Menu Item Description 

Global Detector... Opens the Detector Setup dialog for global 
detector settings. 

Signals... Opens the Signals Setup dialog. 

File Options... Opens the File Options dialog. 

User Interfaces... Opens the User Interfaces dialog. 

Excitation Energies... Opens the Excitation Energies dialog. 

Low Pass, High Pass Selects an element set depending on 
instrument for high or low pass ranges. This 
group of menu items is customized from the 
Element Installation dialog. 

 
Note: The high voltage cable connections to the HV supplies should be checked before changing 
the element set in the software. Each element set corresponds to a specific supply configuration. 

3.6.6 Calibration Menu 

 

Figure 5: The Calibration menu. 

3.6.6.1 Calibration Menu Items 

Table 7: Calibration menu items. 

Menu Item Description 

Voltages... Opens the Voltage Calibration dialog. 

Detector... Opens the Detector Calibration dialog. 

Spin Detector... Opens the Spin Detector Calibration dialog 
(Option for spin systems only) 

Control Supplies... Opens the Control Supplies dialog. 
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3.6.7 Sequence Menu 

 

Figure 6: The Sequence menu. 

3.6.7.1 Sequence Menu Items 

Table 8: Sequence menu items. 

Menu Item Description 

Run Starts an acquisition with the current 
sequence and region settings. 

Stop after Region Stops the acquisition after the region has 
finished each of its sweeps. 

Stop after Sequence Stops the acquisition after the sequence 
has finished each of its regions. 

Stop after Sweep Stops the acquisition after the current 
sweep. 

Number of Sweeps... Control the number of sweeps for the 
current region. 

Jump to next Region Finishes the acquisition of the current 
sweep, and starts the next region. 

Jump to next Sequence Finishes the current region, and starts 
the next sequence. This command is 
only applicable when using multiple 
sequences 

Force Stop Forces the current acquisition to stop 
immediately. Incomplete data from the 
current sweep is discarded, but data 
from earlier sweeps is kept. 

Setup... When using multiple sequences, opens 
the Sequence List Editor for acquisition 
setup. Otherwise, opens the Sequence 
Editor. 
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Note: If the Autosave option is checked in the File Options dialog, all stop commands will save 
acquired data. 
 
Note: If the Zero voltages option is checked in the Acquisition tab of the SES Options dialog, 
Force Stop works effectively as an emergency button, resetting all supplies to zero. This is 
important when working with experiments that might expose the detector to hazardous 
countrates. 

3.6.7.2 Controlling the Number of Sweeps 

 

Figure 7: The Number of Sweeps dialog. 

It is possible to adjust the number of sweeps of the current region during acquisition. To do this, 
select Sequence/Number of Sweeps... which opens the Number of Sweeps dialog that allows the 
total number of sweeps to be changed for the region being acquired, and for subsequent regions. 
 

3.6.7.3 Progress Bar in Swept Mode Acquisitions 

 

 

Figure 8: The swept mode acquisition progress bar. 

During swept mode acquisition, the progress bar below the spectrum display is red for a period 
before the spectrum starts to build up. This reflects the so called pre-steps necessary for constant 
dwell time along the whole energy range of the sweep. Figure 9 illustrates the principle. 
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Figure 9: Swept mode principle. 

Two definitions of channels are illustrated in the picture, the Spectrum channels (denoted Sn : {1 
≤ n ≤ 12}) and Detector channels (denoted Dn: {1 ≤ n ≤ 5}). For a complete sweep, the 
measurement need to be started with the major part of the detector outside the lower limit of the 
energy range (see step -4 in the figure). The first channel in the spectrum cannot be shown on the 
display until data from step -4 up to step 0 has to be acquired. This is done in the so called pre-
steps that is indicated by red on the progress bar. When the first spectrum channel (S1) is 
completed, the progress bar turns green. 
 
Note: The last four steps are done with part of the detector outside the upper limit of the 
spectrum range, but the progress bar stays green all the way to the end, since these steps deliver 
fully accumulated spectrum channels (in contrast to the pre-steps). 

3.6.8 Help Menu 

 

Figure 10: The Help menu. 

3.6.8.1 Help Menu Items 

Table 9: Help menu items. 

Menu Item Description 

About SES... Opens the About SES information window. 

S1 S2 S3 S4 S5 S6 S7 S8 S9 S10 S11 S12 

D1 D2 D3 D4 D5 

D1 D2 D3 D4 D5 

D1 D2 D3 D4 D5 

… 

Step -4 

Step -3 

Step 0 
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4 SETUP 

4.1 Introduction 

This section describes how to setup the parameters for all functions and features in the SES 
software. 

4.2 Detector Graph Library 

4.2.1 Description 

In order to run a detector camera in SES 1.4.0 and later, the main detector interface library 
Detector Graph must be installed. Older versions use the Detector_DCAM library. The basic 
detector settings for resolution, noise reduction, image monitoring and data streaming can be 
controlled from the Filter Setup dialog (see Figure 11) included in Detector Graph. The camera 
data frames flow through a series of “filters” on the way to the spectrum. 

4.2.2 Access 

 Open the Instrument Installation dialog by selecting Installation  Instrument… from 
the SES menu bar. 

 Select the Detector_Graph.dll library in the Detector Interface field if not already done. 

 Open the Filter Setup dialog by clicking the Setup… button for the detector interface. 

4.2.3 Filter Setup Dialog 

 

Figure 11: The Filter Setup dialog 

4.2.3.1 Camera Source 

The specific camera model is installed by clicking on the Browse button at Change Source in the 
Filter Setup dialog and selecting the camera source library. The library for the Basler camera 
family is named CameraBasler.dll. If no camera is attached to the computer, the 
CameraDummy.dll library can be used for simulation of camera test patterns. If Detector Graph 
fails to open and access a camera source library, it will open the camera dummy library by default. 
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4.2.3.2 Basler Camera Setup Dialog 

Figure 12 shows the Basler Camera Setup dialog which is opened by clicking the Camera Basler 
Setup button in the Filter Setup dialog. 
 

 

Figure 12: The Basler Camera Setup dialog 
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The Basler Camera Setup dialog is specially designed for the Basler camera family. The 
parameters are described below: 

Reachable cameras 

The spectrometer detector camera should be selected in the Identification field. In the Ethernet 
case, multiple cameras will appear in the list if the computer connects to other cameras on the 
local network. The factory settings of the IP addresses and spectrometer sub-net should prevent 
this situation but it may happen if the addresses in the rest of the network are set in an 
unfavorable way. 

Video Mode 

Each camera model has specific video modes that defines the image data format. The Scienta 
Omicron spectrometers normally run monochromatic 8 bit data (video mode Mono8). 

Binning 

The pixels of the camera chip can be binned for reduction of data transferred on the camera link. 
Binning increases the maximum number of frames per second that can be processed by the SES 
program, while the image resolution is reduced naturally. 
Without binning (both horizontal and vertical values set to one), full resolution of the images is 
achieved. The binning values control how many camera chip pixels that are integrated into one 
data pixel. For example, if both horizontal and vertical binning are set to two, the pixel data map 
is reduced to 25% in size. The horizontal direction (X) is the same as the energy dispersive 
direction of the spectrometer. The vertical direction (Y) is the same as the angular dispersive 
direction of the spectrometer. 
 
Note: The Energy Scale and Y Scale parameters in the Detector Calibration dialog are NOT 
automatically changed when the binning is changed. These parameters have to be set manually by 
the user for each case of binning. Otherwise the measured spectra will show wrong scales on the 
axes. For optimum performance, the detector also has to be re-calibrated in the Detector 
Calibration dialog for each case of binning. The reason for this is that the SES program 
architecture is based on only one camera at a time with a constant set of parameters. If the user 
changes the camera settings it will affect all regions in all sequences. Hence, binning is not meant 
to be changed by normal users. It is a feature that should be used by experts during camera 
detector evaluation. 

Framerate 

The framerate defines the frames per second that are transferred over the camera link. If the user 
sets it too high, the software will automatically correct it to the maximum allowed value 
depending on the binning. 
The maximum frame rate can be measured by clicking the Estimate button. 
 
The maximum allowed frame rate does not increase even if the camera frames are binned into 
smaller pixel maps. This is due to the design of the camera and has nothing to do with SES 
program. The camera always reads out all sensor pixels internally, even if the frames in the 
camera link communication are binned. In other words, binning speeds up the data processing in 
SES but not the maximum framerate in the camera. 
 
The Exposure Time Base is the period of the internal system clock of the camera given in 
microseconds. This is camera specific and should not be changed by the user. 
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Camera Control 

Shutter defines the acquisition time window for each frame, given in Exposure Time Base units. 
This value is automatically calculated when the framerate is changed. The user should normally 
not change it. 
 
Brightness defines the intensity offset of the camera output data. High Brightness values gives 
brighter detector images naturally. Brightness is set at the factory for minimum background and 
maximum linearity in the spectra. The user should normally not change it. 
 
Gain defines the amplification factor between the incoming light and the camera output data. 
Gain is set at the factory and the user should normally not change it. 
 
Gamma is a factor for Gamma correction in the camera, which is a non-linear image correction 
algorithm optimizing the usage of bits in the image data. Gamma correction should NOT be 
enabled (the ON checkbox should be unchecked) for normal use of the MCP/camera detector. It 
is just a feature for camera test purposes. 

Crop Pixels 

The First and Last pixels along the X and Y axes defines the outer bounds of the frames that are 
transferred over the camera link. 
It is essential for the spectrometer performance that the center of the MCP detector corresponds 
to the center of the frames. Therefore the Crop Pixel boundaries have to be adjusted each time 
the camera is mounted on a new spectrometer. This is done in the following steps: 

 

1. Set the First and Last crop values to the minimum and maximum respectively. 

2. Close the Instrument Installation and detector dialogs. 

3. Start Voltage Calibration and select suitable conditions for detection of electrons all over 
the detector surface. 

4. Turn on the excitations source and ensure that the detector is hit by electrons at a rate 
that allows the circular edge of the MCP to be clearly seen in the corners of the detector 
window after some seconds of acquisition. 

5. Close Voltage Calibration and perform a fix mode measurement until the circular edge is 
sharp with good statistics. The number of slices in the angular dispersive direction should 
be maximized. 

6. Open the data file in Igor and fit a circle to the image of the MCP. 

7. Determine the coordinates for outer bounds of the fitted circle. 

8. Enter the corresponding crop pixels in the Basler Camera Setup dialog. 

Note: The direction of the vertical axis (Y) of the camera is opposite to the vertical axis 
of the SES spectrum image. The Y values from Igor must therefore be “turned upside 
down” and shifted before entered as Crop pixel Y limits. 

9. Close the dialogs and repeat the fix mode measurement and check that the camera image 
is centered. If not, repeat the procedure with the fitted circle and revise the calculations 
involved. 
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Note: The crop pixel boundaries are automatically adjusted if the binning is changed. 

External Trigger 

Acquisition of camera frames can be triggered by an external trigger pulse or a software event as 
an alternative to the freewheeling continuous exposure mode that is the normal mode for 
spectrum acquisition. 
If Software trigger mode is selected, one frame will be acquired and delivered to SES for each 
click on the Take Frame button. If Hardware trigger mode is selected, the frames will be 
triggered by external TTL pulses sent directly to the camera. Hardware triggering allows to 
synchronize the spectrum acquisition to external equipment (light sources, shutters, sample 
manipulators etc.). 

4.2.3.3 Denoise Setup Dialog 

Figure 13 shows the Denoise Setup dialog which is opened by clicking the Denoise Setup button 
in the Filter Setup dialog. 
 

 

Figure 13: The Denoise Setup dialog 

The Denoise Setup dialog is a general feature for all camera detectors. Data from the camera is 
filtered in a sequence of steps (ordered from top to bottom in the dialog). Each step (i.e. filter) 
can be activated/deactivated by a click in the corresponding checkbox. The filters are described 
below. 
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Local Zero Level Subtraction 

The dark background level is not homogenous over the camera chip surface. Therefore the 
background level in each pixel (the local zero level) can be measured and subtracted from the 
data for a perfectly “flat” camera image. This is done in the following way: 

 

1. Turn off the MCP voltage in order to be sure that no counts will be detected by the 
camera. 

2. Check that the camera holder is firmly mounted onto the spectrometer. 

3. Enter the number of frames that will be accumulated during the local zero level 
acquisition. Increasing the number of frames will reduce the noise, but 50 frames is 
enough as a rule of thumb. 

4. Enter the Base Name for the background level file to be created. 

5. Click the Create button and wait for the acquisition to finalize (time = Number of 
frames/Frame rate). 

6. Close the dialogs and exit SES. 

7. Make sure that the local zero level file has been created. 

8. Restart SES. 

 
When the procedure above is performed and when the Local Zero Level Subtraction is activated, 
each pixel of the data frames from the camera is subtracted by the measured local zero level. 
 
Note: If the binning values, or the crop pixels, are changed in the camera Setup dialog, the 
creation of a local zero level file has to be repeated. Otherwise the size of the local zero level file 
and the size of the data will mismatch and the camera software will fail. 

Global Zero Level Subtraction 

Background reduction is done in the most accurate way by local zero level subtraction as 
described above, but the user can also play with constant background reduction (global zero level 
subtraction) for diagnostic purposes. With this method, a constant value is subtracted from all 
pixel values in the data frames from the camera. 
Some cameras are working in interlaced mode and therefor there are two different constants for 
the subtraction. The Odd constant is subtracted from the pixels in the odd rows, and the Even 
constant is subtracted from the pixels in the even rows. For non-interlaced cameras these two 
constants should be identical. 

Global Bit Operation 

The global bit operation is the first step of the intelligent noise reduction algorithm. The pixel 
values can be divided, multiplied or rounded down after the background reduction. This 
operation affects the signal to noise ratio and the feature is mainly implemented for factory tests 
and tuning. Normal users should not change the global bit operation setting. 
The global bit operation is a pure digital operation on binary bit level. 
Shift Right means that the pixel value bits are shifted a specific number of steps to the right, 
which is the same as dividing the values by a power of two (the least significant bit is located to 
the right). 
For example: If the Shift Right value is 3, the pixel values are divided by 8. 
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Shift Left works opposite to Shift Right which makes it a multiplication by a power of two. 
Clear Lowest means that a specific number of the least significant bits are set to zero. 

Spot Denoiser 

The Spot Denoiser has a set of parameters that controls the performance of the intelligent noise 
reduction algorithm. Most of them is purely implemented for detector investigations and 
software development and they are by default set to zero. Therefore only the most important one 
is described here. 
The Minimum Spot Neighbors value controls whether non-zero pixel data should be detected as 
counts or not. If a group of non-zero pixel neighbors consists of less pixels than the Minimum 
Spot Neighbors value, it will be discarded as noise. 
In the same way as the global Bit Operation, the Spot Denoiser is mainly implemented for 
factory tests and tuning. Normal users should not change the Spot Denoiser settings. 

4.2.3.4 SES Detector Viewer Dialog 

Figure 14 shows the SES Detector Viewer dialog which is opened by clicking the Real-time 
Monitor Setup button in the Filter Setup dialog. 
The SES Detector Viewer parameters do not affect the spectrum data. They only change the 
camera image on the PC monitor, so the user can play with it without risking the performance of 
the spectrometer. 
 

 

Figure 14: The SES Detector Viewer dialog 

A cross cursor appears/disappears when the Cross button is clicked. This can be helpful during 
sample alignment. 
The image freezes/unfreezes when the Pause button is clicked. 
The Discriminator value is implemented for background noise reduction. All pixels that have 
lower intensity than the Discriminator value are set to zero (black). 
The Bitshift value controls the brightness of the image. All pixel values that are above the 
Discriminator level are shifted a number of steps to the left, which is the same as multiplying the 
values by a power of two (the least significant bit is located to the right). 
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The SES Detector Viewer dialog will be automatically opened when SES is re-started if the 
Default Open checkbox is checked. 
The SES Detector Viewer dialog is always shown on top of other windows on the PC monitor if 
the On Top checkbox is checked. 

4.2.3.5 Snapshot Saver 

Figure 15 shows the Snapshot Saver dialog which is opened by clicking the Snapshot Setup 
button in the Filter Setup dialog. 
 

 

Figure 15: The Snapshot Setup dialog 

The Snapshot Saver enables storage of a continuous stream of raw camera frames on disk. 

4.3 Global Detector Settings 

4.3.1 Description 

The Global Detector Setup dialog defines the size and shape of the detector area and how this 
area is divided into slices for 2-D image acquisition. The global detector settings are applicable to 
all acquisition regions not having local detector settings (see section about local detector settings 
below). 

4.3.2 Access 

 From the Setup menu on the SES menu bar, select the Global Detector item. (Setup  
Global Detector…) 

 In the Sequence Editor, click the Setup Detector button. 
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4.3.3 Dialog 

 

Figure 16: The Global Detector Setup dialog with a dummy detector test pattern 

4.3.3.1 Energy Channels 

Energy Channels define the channel range in the energy direction of the detector.  
Reducing the energy range to the central part of the detector mainly improves angular resolution.  
 
Note: The channel limits can be changed either by their entry fields, or by dragging the range 
markers in the detector window. 

4.3.3.2 Y Channels 

Y Channels define the channel range in the angular or spatial direction of the detector.  
When only one slice is used, there are no restrictions on how to select the range of Y Channels. 
 
Note: The channel limits can be changed either by their entry fields, or by dragging the range 
markers in the detector window. 

4.3.3.3 Slices 

Slices define the number of partitions of equal height into which Y Channels should be divided. 
Unless the detector system has only Energy Channels, the Y Channels can be divided into a 
number of Slices. When only one slice is used, data is summed over all Y Channels and presented 
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as a one dimensional spectrum in the energy dispersion direction. When more than one slice is 
acquired, the data can be presented in the following ways: 

 A one dimensional spectrum summed over all Y Channels as in the single slice case. 

 Multiple one-dimensional spectra, one for each slice. 

 An image representation of the two dimensional spectrum. 
 
Note: When choosing a number of slices larger than one, there are enforced restrictions on the 
range of Y Channels. The number of Y Channels must be an even multiple of the slices, and this 
is handled automatically by the Detector Setup dialog. The spin edits and the range markers for Y 
Channels behave differently in this context. 

4.3.3.4 Detector Modes 

Detector Mode defines whether the detector system should use ADC or Pulse Counting 
acquisition. 

ADC Mode 

In ADC mode, which is the most commonly used mode (also named Greyscale mode in older 
systems), the flash intensities from all pixels over the detector surface contribute to the spectrum. 
Each flash has individual intensity and size, covering a number camera pixels. In order to 
normalize the intensity scale in ADC mode to the real countrate, the so called Multiple Counting 
Factor (MCF) can be used. It has to be calibrated prior to the measurement. See more details 
about MCF in the Detector Calibration section. 
The ADC mode is valid for all intensities, all the way from zero up to the operating limit of the 
MCP plates but the linearity is not as good as for the Pulse Counting mode described below. 
Noise reduction is performed before data accumulation to the spectra independently of the 
selected mode. 

Pulse Counting Mode 

In Pulse Counting mode, each flash from an electron event is transformed to a single pixel event 
with a unified intensity, located at the centre of the flash. This mode is a true particle counting 
method with good linearity, but it is only valid for low intensities up to the countrate limit when 
the detector saturates because of overlapping flashes. The MCF in this mode have no meaning 
and should alwas be set to 1. 

4.3.3.5 Software Correction 

When straight slits are used at the analyser entrance, the detector software has to correct for the 
image bending in order to maintain optimum energy resolution. This is done when the Straight 
Slit checkbox is checked. 

4.3.3.6 Detector Image 

Checking Show Detector Image displays a real time image of the detector. Controls for selecting 
acquisition parameters then become visible. 
The acquisition parameters used for displaying the detector image are similar to those in the 
Voltage Calibration dialog. 
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4.3.3.7 Detector Range Markers 

The detector area used for acquisitions can be defined by dragging the range markers in the 
detector window. 

4.4 Local Detector Settings 

4.4.1 Description 

Each region can have local (individual) detector settings that overwrite the global settings in the 
Global Detector Setup dialog. The local settings (also notated “region defined”) are edited in the 
Detector Setup dialog. 

4.4.1 Access 

 In the Detector area of the Region Editor, check the Use Region Defined Detector 
checkbox, and then click the Setup button. 

4.4.2 Dialog 

The appearance and features of the Detector Setup dialog is exactly the same as for the Global 
Detector Setup dialog. 

4.5 Signal Setup 

4.5.1 Description 

The Setup Detector dialog defines the active window of the detector and how this window is 
divided into slices for image acquisition. 

4.5.2 Access 

From the Setup menu on the SES menu bar, select the Signals item. (Setup  Signals…) 
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4.5.3 Dialog 

 

Figure 17: The Signal Setup dialog. 

4.5.3.1 Input Signals 

The Input Signals area lists the input channels defined in the I/O interface library.  
Input signals can be disabled individually by checking the checkboxes next to the corresponding 
signal name. 

4.5.3.2 Output Signals 

The Output Signals area lists the input channels defined in the I/O interface library.  
Output signals can be disabled individually by checking the checkboxes next to the 
corresponding signal name. 

4.6 File Options 

4.6.1 Description 

The File Options dialog is used for specifying available experiment file libraries and for defining 
parameters such as experiment file-type, save directory and file naming method. 
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4.6.2 Access 

 From the Setup menu on the SES menu bar, select the File Options item. 

(Setup  File Options…) 

 In the Sequence Editor click the File Options button. 

 
Note: When using multiple sequences and accessing the File Options dialog from the Setup 
menu, the file options for the first sequence in the list are displayed. 

4.6.3 Dialog 

 

Figure 18: The File Options dialog. 

4.6.3.1 File Interface Libraries 

The File Interface Libraries area shows the installed experiment file libraries and their respective 
formats. Experiment file libraries can be installed and uninstalled with the Add and Delete 
buttons respectively. 

4.6.3.2 Saved File Format 

The Saved File Format area defines the file type used for saving experiment files. By default, 
three file types are available: 

 Igor Packed Experiment Files (.pxt) 

 Igor Binary Wave (.ibw) 

 text file format (.txt) 
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4.6.3.3 Save Directory 

The Save Directory area defines the base directory and where to save experiment files. 

 If the Sort by Sample or Sort by User checkbox is checked, experiment files will be saved 
in subdirectories to the base directory given in the file path field. 

 If the Autosave checkbox is checked, experiment data will be saved after each time that 
the sequence has completed an execution. Experiment data will then also be saved when 
the sequence is stopped by the user. 

4.6.3.4 File Naming Method 

File Naming Method defines whether experiment file names should be constructed from the date 
and time of the acquisition, or from an incremental number. The file names generated from date 
and time have the format base-mmddhhnn.ext while the file names generated from an 
incremental number have the format base-xxx.ext. 

4.6.3.5 Spectrum Naming Format 

The Spectrum Naming Format field defines how the spectra are named in the experiment files. 
There are three format parameters: 

 %R represents the region name 

 %F represents the experiment file name 

 %N represents the incremental number or date and time of the experiment file name 
 
Example: ‘%R_%N’ would name the spectrum ‘Region1_001’ for a region with name ‘Region1’ 
and incremental number ‘001’. 

4.7 User Interfaces 

4.7.1 Description 

The User Interfaces dialog is used to load and unload plug-ins or user interface libraries for 
auxiliary equipment, such as sample manipulator, monochromator, flood gun and ion gun. 
Loaded plug-ins are listed in the Loaded User Interfaces area. 
A user interface defines so called Run Modes and/or Special Regions that are handled from the 
Sequence Editor when an experiment is setup. 

4.7.2 Access 

From the Setup menu on the SES menu bar, select the User Interfaces item. (Setup  User 
Interfaces…) 
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4.7.3 Dialog 

 

Figure 19: The User Interfaces dialog 

Note: This dialog should only be used by the system administrator. 

4.7.3.1 Add, Delete and Setup Buttons 

 New User Interface plug-ins can be loaded by clicking the Add button and browse for the 
desired plug-in. 

 A plug-in can be unloaded by selecting it in the list and clicking the Delete button. 

 If the selected plug-in has a setup dialog, it can be opened by clicking the Setup button. 
As an example: The general manipulator library plug-in has a setup dialog where a 
hardware dependent library for a particular motor type is selected. 

4.8 Excitation Energies 

4.8.1 Description 

The Excitation Energies dialog is used to define excitation energies, specify default excitation 
energy and to change the current excitation energy. 

4.8.2 Access 

From the Setup menu on the SES menu bar, select the Excitation Energies item. (Setup  
Excitation Energies…) 
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4.8.3 Dialog 

 

Figure 20: The Excitation Energies dialog. 

Note: The Excitation Energies dialog should only be used by the system administrator. 

4.8.3.1 Excitation Energy File 

The file where the defined excitation energies are stored is specified in the Excitation Energy File 
field. A different file can be loaded by clicking the Browse button and browse for the desired file. 

4.8.3.2 Energy List 

 New excitation energies can be defined by clicking the Add button. 

 The selected excitation energy can be renamed or deleted by clicking the Rename or 
Delete buttons respectively. 

 Excitation energies can be moved further up or down the list by clicking the Move Up or 
Move Down buttons. 

 The actual energy for the selected excitation energy can be changed in the Excitation 
Energy field. 
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4.8.3.3 Default Excitation Energy 

The Default Excitation Energy field specifies which excitation energy to use when creating new 
regions. The default excitation energy can be changed either by selecting a predefined energy 
from the drop-down list or by entering a new value. 

4.8.3.4 Current Excitation Energy 

The Current Excitation Energy field specifies the excitation energy currently assigned to the 
instrument. The current excitation energy can be changed by either selecting one of the 
predefined excitation energies from the drop-down list or by entering a new value and clicking 
the Set button. 
 
Note: If a monochromator plug-in is loaded, the Current Excitation Energy field will display the 
current photon energy of the monochromator. When the current excitation energy is changed, 
the new value is assigned to the monochromator. 

4.9 Element Set Selection 

4.9.1 Description 

The spectrometer performance and energy range can be optimized by selection of different 
element sets, i.e. high voltage supply configurations. For example, Low Pass element set should 
be selected for measurements in the lower energy range of the spectrometer. 

4.9.2 Procedure 

1. Zero the output of the HV supplies. That is automatically done when SES is restarted or 
the Voltage Calibration window is closed (if the zero supplies option is selected from 
Options dialog). 

2. Turn off the HIGH VOLTAGE ON/OFF switch.  

3. Connect the cables to the HV supplies in the cabinet to the wanted element set 
configuration. Supplies that are used for the Low Pass element set are denoted L, and 
supplies for High Pass are denoted H. Supplies for other element sets are denoted with 
similar abbreviations. 

4. Select Setup from the SES menu bar and click on the wanted element set name. 

5. Turn on the HIGH VOLTAGE ON/OFF switch.  

6. Open the Voltage Calibration window and check that the element set works as expected. 
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5 CALIBRATION 

5.1 Introduction 

This section describes how to use Calibration dialogs. 

5.2 Voltage Calibration 

5.2.1 Description 

The Voltage Calibration dialog is mainly used for optimizing intensities by changing the Pass 
Energy and the lens deflection elements, calibrating the Energy Offset to compensate for drift, 
and general troubleshooting. 

5.2.2 Access 

From the Calibration menu on the SES menu bar, select the Voltages item. (Calibration  
Voltages…) 
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5.2.3 Dialog 

 

Figure 21: The Voltage Calibration dialog. 

5.2.4 Menus 

The menu bar items in the Voltage Calibration dialog are described below 

5.2.4.1 File Menu 

 

Figure 22: The File menu of the Voltage Calibration dialog. 
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The File menu is used for importing and exporting lens tables, and for exiting the Voltage 
Calibration dialog. 
 
Note: The user should only use the Exit command in this menu. The Import/Export commands 
are there for the system administrator. 

5.2.4.2 View Menu 

 

Figure 23: The View menu of the Voltage Calibration dialog. 

Position, Height, FWHM, Area 

Each of the first four items in the View menu opens a window displaying the corresponding peak 
parameter value. The Area parameter window is shown as an example below. 
 

 

Figure 24: The Area parameter window. 

The parameter windows can be resized for viewing at a distance when performing spectrometer 
system optimization away from the computer. 
The peak parameter values can also be found on Peak Information bar at the bottom of the 
Spectrum Display. 

Energy Range 

This item opens the Energy Range dialog that presents the allowed energy ranges for each lens 
mode and pass energy for the selected element set in a table format. The columns denote pass 
energies in eV, the rows denotes the different lens modes, and the entries in the table are the 
kinetic energy range limits in eV. By double-clicking on a given limit, information about the 
limiting factors is presented. 

External Image 

This item opens the Spectrum Image window displaying the spectrum in two dimensions for 
Angular/Spatial and Spectrum Image display modes. 
 
Note: The images in the Spectrum Image window are not identical to the images in the SES 
Detector Viewer even if they look similar in many cases. The Spectrum Image window present 



 

 

SES Software Manual v5.0  Copyright ©2018 Scienta Omicron AB 

35 

spectral data that is processed by the noise reduction and image transformation algorithms while 
the SES Detector Viewer shows the raw camera data. 

Show Supply Information 

This item opens the Supply Information dialog where the current status of the supply outputs is 
monitored. 

5.2.4.3 Display Mode Menu 

 

 

Figure 25: The Display mode menu of the Voltage Calibration dialog. 

The first four items of the Display Mode menu represent different display modes. The last two 
items controls how to present and accumulate data. 

Energy Distribution Curve 

This item corresponds to a one-slice acquisition, presented as kinetic or binding energy vs. counts 
or countrate in the Spectrum Display. 

Angular/Spatial 

This item corresponds to an acquisition using the maximum number of slices available for 
current selection of Y Channels in the global detector settings. The data is summed over all 
Energy Channels, and then presented as Y channel vs. counts or countrate in the Spectrum 
Display. 

Spectrum Image 

This item corresponds to an acquisition using the maximum number of slices available for the 
current selection of Y Channels in the global detector settings. The data can be presented either 
as an image, or as kinetic or binding energy vs. counts or countrate for each slice individually, or 
summed over all slices. 
 
Note: The Spectrum Image item will have a submenu only if the detector system has a setting for 
Data Bytes. 

Signals 

If this item is checked, signal data will be displayed instead of spectrum data. If the Allow 
acquisition of both Signals and Detector option has been enabled in the SES Options dialog, 
both signal and spectrum data will be displayed simultaneously.  
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Note: Signals are only available if an I/O interface library has been defined in the Instrument 
Installation dialog. 

Intensity as [counts/s] 

If this item is checked, the intensity of the acquired data will be displayed as countrate, rather 
than as counts. 

Add Intensity until Restarted 

If this item is checked, the intensity of subsequent acquisitions are added until either the Restart 
button is clicked, or changes made to the acquisition parameters forces the acquisition to restart. 

5.2.4.4 Edit Menu 

 

 

Figure 26: The Edit menu of the Voltage Calibration dialog. 

Lens Tables 

This item opens the Lens Table Editor for the currently selected lens mode and pass energy. 
 
Note: The user should not change the lens table values except for the lens deflection elements. 

5.2.5 Instrument Parameters 

The Instrument Parameters area specifies the setup of the continuous acquisition, as well as the 
current element selection. When the Voltage Calibration dialog is opened, it immediately starts a 
continuous fixed mode acquisition using default parameters. For the detector, it uses the full 
range of Energy Channels. It uses a Slices setting dependent on Display Mode and for the 
remaining parameters it uses values from the global detector settings. 
 
Note: If the user does not have write permission to Instrument.dat, changes cannot be made to 
element voltages, including the lens deflection elements. Likewise, if the user does not have write-
permission to RunVar.dat, changes cannot be made to Energy Offset. 

5.2.6 Voltages 

The Voltages area specifies the current kinetic or binding energy and displays the voltage of the 
selected element. 

5.2.7 Offsets 

The Offsets area specifies the Energy Offset of the analyser, and the pass energy offset for the 
currently selected pass energy. The Ep Offset parameter is calibrated and should not be changed. 
The Energy Offset parameter can be used to compensate for energy drift in the experiment 
setup, and it can also be used for defining the work function. The Calibrate buttons perform 
automatic calibrations for the corresponding energies. When clicking on a Calibrate button, SES 
attempts to locate the highest peak shown on the image and shift it to the Kinetic Energy 
specified in the Voltages area (see above). 
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5.2.8 Lens Curve 

The Lens Curve graph displays the lens table for the currently selected Element, if it depends on 
kinetic energy. 

5.2.9 Table Entry 

The Table Entry area provides means to navigate through the discrete kinetic energy/voltage 
pairs of the lens table for the currently selected element, if it depends on kinetic energy. 

5.2.10 Spectrum Display 

The spectrum display presents the spectrum of the current acquisition as a graph or as an image 
representation. 

5.2.11 Signal Display 

The signal display presents the signal data of the current acquisition. 

5.2.12 Peak Information Bar 

The Peak Information bar at the bottom of the spectrum display in the Voltage Calibration dialog 
is identical to the bar in the main spectrum display. More details can be found in the Operating 
the Spectrum Display section. 

5.3 Lens Deflector Optimization 

5.3.1 Description 

The two lens deflection elements called Up/Down and Left/Right can be used to optimize the 
sample position with regard to intensity or resolution. This is valid for all lens modes except the 
DA30 deflection modes where the lens deflectors are controlled automatically during the angular 
scans. Up/Down and Left/Right are in this case part of the DA30 double deflector units, and if 
the user tries to control them manually, the angular spectra will be distorted. 

5.3.1 Procedure 

1. Select the lens deflection element that should be optimized in the Element field of the 
Voltage Calibration dialog. The lens table for the element will be plotted as a curve in the 
Lens Curve graph. 

2. Use the Element Voltage field in the Voltage Calibration dialog to adjust the voltage for 
the lens deflection element while watching the properties on the Peak Information bar at 
the bottom of the spectrum display. 
 
Note: Changing settings related to the acquisition will force a restart, and the Element 
Voltage for the lens deflection element will revert back to its initial value. See the Lens 
Table Modification section for instructions on how to save the new lens deflection 
voltages in the lens table. 

3. When optimizing for intensity, maximize the peak height (or total spectrum area in the 
absence of sharp features). When optimizing for energy resolution, minimize the peak 
FWHM, while maintaining the peak height. 
 
Note: In general it is beneficial for the spectrometer performance to operate the lens 
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with zero deflection. It is therefore better to optimize the intensity by making the 
experiment alignment as good as possible before playing with the deflectors. 

5.4 Lens Table Modification 

5.4.1 Description 

When optimal voltages for a lens deflection element have been found, the lens table needs to be 
changed to reflect this. This can be carried out from the Voltage Calibration dialog either by 
using the Table Entry area or the Lens Table Editor.  
 
Note: Users should never change the lens tables for elements other than the Up/Down and 
Left/Right lens deflection elements. 

5.4.2 Table Entry 

Perform the following steps for modification of a lens table via the Table Entry area in the 
Voltage Calibration dialog: 

 To change the element voltage of a lens table point, navigate the cross cursor along the 
lens curve to the point of interest with the navigation buttons, and enter the desired value 
in the Element Voltage filed. 

 To delete a point, navigate to it and click the Delete button. 

 To insert a new point at the current kinetic energy, enter the desired value in Element 
Voltage and click the Insert button. 

5.4.3 Lens Table Editor 

 

Figure 27: Detail of the Lens Table Editor showing the lens tables of four lens elements. 

Open the Lens Table Editor from the Edit menu. To change element voltage for a point, edit the 
cell in the Voltage column for the corresponding kinetic energy. To delete a point, select a cell in 
the Ek or Voltage column and press the Delete key. To insert a new point, select an empty cell in 
the Ek column, enter the desired kinetic energy for the point, press the Enter key and then edit 
the element voltage. 
 
Note: A lens table must contain at least two points. 

5.4.4 Saving Lens Table Changes 

After a lens table has been edited, changes should be saved by clicking the Ok button and 
confirming the changes. 
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5.5 MCP Detector Calibration 

5.5.1 Description 

The Detector Calibration dialog is used to calibrate the basic energy and angular or spatial scales 
of the detector. It is also used to calibrate an energy correction curve compensating for non-
linearities in the energy dispersive direction of the detector. 

5.5.2 Access 

From the Calibration menu on the SES menu bar, select the Detector item. (Calibration  
Detector…) 

5.5.3 Dialog 

 

Figure 28: The Detector Calibration dialog. 
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Note: This dialog should only be used by the system administrator. 

5.5.3.1 Calibration Mode 

The basic acquisition parameters of the instrument are specified in the Calibration Mode area. 

5.5.3.2 Energy Correction Diagram 

The Energy Correction Diagram displays the calibration curve for the current pass energy. The 
curve is cleared by clicking the Clear button. 

5.5.3.3 Energy Scale 

The Energy Scale field specifies the basic energy scale (i.e. dispersion) of the detector. Energy 
scale calibration can be started by clicking the Optimize button and stopped by clicking the Stop 
button. 

5.5.3.4 Y-scale 

The Y-scale field specifies the basic angular or spatial scale (i.e. dispersion) of the detector. 

5.5.3.5 Multiple Counting Factors 

The Multiple Counting Factor (MCF) area specifies the relation between the raw spectrum 
intensity and the presented spectrum intensity in ADC and Pulse Counting acquisition modes. 
The presented intensity is equal to the raw intensity divided by the MCF. 
The MCF for ADC mode represent the integrated intensity of one average flash from the 
detector. Hence, the presented intensity becomes a good approximation to the real countrate. All 
pass energies should have individually calibrated MCF’s for ADC mode. 
The MCF for Pulse Counting mode should always be set to 1 which gives that the spectrum 
intensity scale will represent true counts per time unit. Other settings have no meaning. 

5.5.3.6 Calibration Parameters 

The Calibration Parameters area specifies the instrument settings for the continuous acquisition, 
the basic energy scale calibration and calibration of the energy correction curve. 

 The Kinetic and Binding buttons specify whether to use kinetic or binding energy for the 
energy scale. 

 The Kinetic Energy field specifies the centre energy of the acquisitions. The Width field 
specifies the width of the energy window used for the sweeps when calibrating energy 
correction curves. 

 The Swept Time field specifies the step time used for the sweeps when calibrating energy 
correction curves. 

 The Fixed Time field specifies the acquisition time for the continuous acquisition and for 
the basic energy scale calibration. 

5.5.4 Procedure 

1. Setup the spectrometer for measurement of a sharp spectral feature with low background 
(e.g. the Xe line in a gas cell setup, or the Fermi edge in a solid sample experiment). 

2. Select File  Options  Spectrum Correlation from the SES menu bar and select 
Peak or Fermi edge as the spectrum type. 
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3. Open the Voltage Calibration dialog, select Transmission lens mode.  

4. Find a spectral line peak or the Fermi edge. High signal-to-noise ratio is beneficial. 

5. Close the Voltage Calibration dialog and open the Detector Calibration dialog. 

6. Select the pass energy for the calibration. 

7. Check that the peak or the Fermi edge is still in the centre of the spectrum window, 
otherwise adjust the kinetic energy. 

8. Change the spectrum window width so the peak FWHM or the Fermi edge slope covers 
10% of the window. 

9. Click on Calibrate. A GO button should appear in the upper right corner of the 
spectrum. 

10. Centre the peak or the Fermi edge slope between the two red vertical bars by adjusting 
the Offset parameter. 

11. Click the GO button to start the acquisition of the calibration curve. Initially, the 
software scans the full range of the spectrum window showing the Drift Region progress 
bar. Thereafter the peak (or Fermi edge) are scanned multiple times while the Area 
progress bar is shown. 

 

 

Figure 29: The Drift Region progress bar during detector calibration. 

 

 

Figure 30: The Area progress bar during detector calibration. 

 

12. Click on Stop when the complete dispersion calibration curve is acquired with good 
statistics. 

13. Repeat the calibration procedure for the other pass energies. 

14. Click OK to save the calibration data and exit the Detector Calibration dialog. 

5.6 MCP Voltage Optimization 

5.6.1 Description 

As the MCP unit ages when the spectrometer is in operation, a slight increase in the voltage will be 
necessary over time. In order to compensate for aging, the steps below should be followed. 

5.6.1 Procedure 

1 Select Pulse Counting detector mode via Setup  Global Detector. 
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2 Open the Voltage Calibration window, and make sure that the intensity is about 500 
counts/sec evenly spread on the detector. 

3 Increase the MCP voltage in steps of 20 Volts and plot the intensity (total area) vs MCP 
voltage. Continue until the intensity converge to a constant level (do not exceed the 
maximum MCP voltage). The intensity should typically increase linearly with the MCP 
voltage up to this level. 

4 Set the MCP voltage just above the point where the plotted curve flattens out.  

5 Save this new MCP voltage and exit the Voltage Calibration dialog by clicking OK. 

5.7 Spin Detector Calibration 

5.7.1 Description 

The Spin Detector Calibration dialog is used to calibrate the spin channel energy scale.  

5.7.2 Access 

From the Calibration menu on the SES menu bar, select the Spin Detector item. (Calibration  
Spin Detector…) 
 
Note: This dialog will only show up if there is an External I/O module installed and configured 
as a Spin Detector. 
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5.7.3 Dialog 

 

Figure 31: The Spin Detector Calibration dialog 

Note: The Spin Detector Calibration dialog should only be used by the system administrator. 
 
The Spin Detector Calibration dialog is capable of handling multiple spin detectors, shown in 
different tabs at the top of the dialog. When opening the dialog, a measurement is automatically 
started, and can subsequently be restarted by clicking on the Restart button. 

5.7.4 Instrument Parameters 

Basic acquisition parameters of the instrument are specified in the Instrument Parameters area. 

5.7.5 Sweep Parameters 

The Sweep Parameters area manages the sweep settings to be used for sweep mode acquisitions 
during the spin detector calibration. 

5.7.6 Energy Calibration 

The energy offset can be automatically calibrated by clicking the Calibrate button. This 
calibration will set the energy offset for all spin channels. The procedure is to first set the Kinetic 
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Energy in the Sweep Parameters area, whereupon the desired peak should be visible in the 
spectrum view. Clicking Calibrate will then move the peak to match the correct kinetic energy. 

5.7.7 Multiple Counting Factors 

The MCF values are determined individually for each spin channel. To get the best result, the 
energy calibration should be done before starting this. The peak should be at the center of the 
graph, and when clicking Calibrate, the peaks from all spin channels will be normalized to the 
same intensity. 

5.8 Supply Control 

5.8.1 Description 

The Control Supplies dialog is used to display and change the voltages assigned to specific 
supplies. It is used solely for troubleshooting the operation of the supplies. 

5.8.2 Access 

From the Calibration menu on the SES menu bar, select the Control Supplies item. (Calibration 

 Control Supplies…) 

5.8.3 Dialog 

 

Figure 32: Example of the Control Supplies dialog. 

Note: The Control Supplies dialog should only be used by the system administrator. 
 
Note: The zero value for high voltage supplies generally differ from 0 by a small amount. 
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 The supply voltage indicators can be dragged and dropped to resemble the layout of the 
high voltage. 

 If a supply is within its operational range, this is indicated by the green colour of the 
numbers in the voltage indicator. If it is outside its operational range, the colour will be 
red. 

 A specific supply can be brought to its extreme max and min values by clicking the 
respective button at the bottom of the supply voltage indicator. 

 The voltage assigned to a specific supply can also be changed by entering a new value and 
pressing the Enter key. 

 

Figure 33: The Voltages menu of the Control Supplies dialog. 

 The Zero All command in the Voltages menu sets all supplies to their zero values. 

 The Send Repeatedly command in the Voltages menu forces the assigned voltages to be 
sent to the supplies repeatedly with a 100 ms delay. 
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6 SEQUENCE 

6.1 Introduction 

This section describes how to use the Sequence and Region Editors, explains the Run Modes, 
Special Regions and how to compensate for energy drifts during data acquisition. 

6.2 Sequence List Editor 

6.2.1 Desciption 

The Sequence List Editor defines sequences to be run in an experiment batch. Each sequence in 
the sequence list uses individual settings. 

6.2.2 Access 

From the Sequence menu on the SES menu bar, select the Setup item. (Sequence  Setup...) 
 
Note: The Sequence List Editor is only available if the Use Multiple Sequences option in the SES 
Options dialog is selected. 

6.2.3 Dialog 

 

Figure 34: The Sequence List Editor. 

6.2.3.1 Sequence List 

The sequence list displays the sequences available for execution: 

 The right column displays the file names of added sequences. 

 The left column displays the number of enabled regions in the corresponding sequence. 

6.2.3.2 Edit Buttons 

The following buttons are available for editing the sequence list: 

 To create a new sequence, click the New… button. The new sequence is added to the end 
of the list. 
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 To open one or more existing sequences, click the Open… button. The selected 
sequences are added to the end of the list. 

 To edit the selected sequence in the Sequence Editor, click the Edit… button. 

 To create a copy of a selected sequence, click the Copy… button. 

 To delete the selected sequence(s) from the list, click the Delete button. 

 To move the selected sequence(s) up or down in the queue, use the Up and Down 
buttons. 

 
Note: Deleting a sequence from the sequence list does not delete the corresponding sequence 
file. 

6.3 Sequence Editor 

6.3.1 Description 

The Sequence Editor defines the regions to be run in an experiment, which run mode to use and 
where to save resulting data. 

6.3.2 Access 

 When using multiple sequences, double-click a sequence file or click the Edit button in 
the Sequence List Editor. 

 Otherwise, from the Sequence menu on the SES menu bar, select the Setup item. 

(Sequence  Setup…) 

6.3.3 Dialog 

 

Figure 35: The Sequence Editor. 
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6.3.3.1 Sequence File Name 

The file name of the active sequence is shown in the Sequence Editor title bar. 

6.3.3.2 Menu Bar 

 

Figure 36: The File menu of the Sequence Editor. 

The File menu provides commands to open, save and create new sequences. It also provides 
commands to create new regions. 
 

 

Figure 37: The Edit menu of the Sequence Editor. 

The Edit menu provides commands to copy, cut, paste and delete regions. 

6.3.3.3 Acquisition Region 

The regions marked as active will be executed sequentially when an experiment is started. 

 To activate a region, click the centre of the cell of the first column so that it turns green 

and the -symbol appears. 

 To deactivate a region, click the cell so that it turns red and the -symbol appears. 
 
Shaded columns are read only, and can be used to move regions up and down in the table. The 
second column of the region table defines the type of acquisition for the corresponding region: 

 D – acquisition using detector 

 r – acquisition using region defined (local) detector settings 

 S – acquisition using signals 

 U – user interface region 
 
Note: The Total Time column displays the estimated time to complete one acquisition of the 
region. This includes the number of repetitions defined in the region in the calculation, but not 
analyser delays. 
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6.3.3.4 Experiment Information 

The Info area allows for miscellaneous experiment information to be entered including a file 
name prefix for saving experiment data. 

6.3.3.5 Sequence Run Mode 

The Sequence Run Mode area defines how the software should perform the acquisitions and save 
the data for all acquisition regions not having local run modes. 
 
Note: Most combinations of region and sequence run modes are not allowed for logical reasons 
(see section about global and local run modes). 

6.3.3.6 Buttons 

 To edit the global detector settings, click the Setup Detector button. 

 To edit the file options for this sequence, click the File Options button. 

6.3.4 Saving Experiments 

 With the exception of the File Name field, all information entered in the Info area will be 
saved with the experiment in the output file(s). The text in the File Name field will be 
used as a prefix in the output file names. 

 If the Sort by User option is used, experiments will be saved in a subdirectory named as 
User. 

 If the Sort by Sample option is used, experiments will be saved in a subdirectory named 
as Sample. 

 If both Sort by User and Sort by Sample options are used, experiments will be saved in 
subdirectories of the form \User\Sample. 

6.3.5 Region Management 

Acquisition regions can be added, edited, copied, and deleted in various ways including Ctrl-key 
shortcuts. 

 A new region is created (CTRL+R), through the Region command in the New submenu 
of the File menu, or the New button. 

 Regions can be copied, cut, pasted and deleted in the following three ways: 

1. Using Ctrl-keys: CTRL+C, CTRL+X, CTRL+V, and the DEL-key. 

2. Selecting the items in the Edit menu. 

3. Clicking the buttons in the Region area. 

 To edit a region, double click the corresponding row in the region table to bring up the 
Region Editor, or edit the cells in the region table directly. 

 To move a region, click and hold on any of the read-only columns of the region table 
with the mouse, or hold the CTRL key and use the Up and Down keys. 
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6.4 Region Editor 

6.4.1 Description 

The Region Editor handles the parameter settings of the acquisition regions. The fundamental 
settings for a region are lens mode, pass energy, and energy range. In addition to this, there are 
region specific detector settings and run modes. 

6.4.2 Access 

In the Sequence Editor, double click a row in the region table. 

6.4.3 Dialog 

 

Figure 38: The Region Editor. 

Note: Changes made to a region in the Region Editor will be saved when the Sequence Editor is 
closed or the Save Sequence or Save Sequence As commands are used. 
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6.4.3.1 Name 

The Name field provides a means to rename the currently selected region, as well as changing 
which region in the current sequence to edit. 

6.4.3.2 Lens Mode 

The Lens Mode field lists the lens modes available for the instrument. 

6.4.3.3 Pass Energy 

The Pass Energy field lists the pass energies available for the selected lens mode. Choosing a 
higher pass energy results in higher intensity and a wider energy range, at the expense of energy 
resolution. 

6.4.3.4 Run Mode 

The Run Mode area defines how the software should perform the acquisitions and save the data 
for the specific region. 
 
Note: Most combinations of region and sequence run modes are not allowed for logical reasons 
(see section about global and local run modes). 

6.4.3.5 Acquisition Mode 

The Acquisition Mode area defines whether the region should be measured using fixed mode or 
swept mode. In fixed mode, the energy is kept fixed for the duration of the acquisition, so that a 
snapshot of the selected detector area is produced. The energy range is restricted by the energy 
width of the detector, which is typically about 10% of the pass energy. In swept mode, the energy 
is incremented by the energy step, starting with the low energy. Each step in energy corresponds 
to one point of the spectrum, and each step in energy is also integrated over the selected area of 
the detector. 

6.4.3.6 Energy Mode 

The Energy Mode area defines whether binding energy or kinetic energy should be used for 
defining the low and high energies and for the energy scale of the spectrum. 

6.4.3.7 Energy 

The Energy area defines the energy range of the region. It provides means of changing the energy 
range either by low and high energy, or by centre energy and energy width. The values in the 
Energy area are either in binding energy or kinetic energy, depending on the selected Energy 
Mode. If fixed acquisition mode is selected in Acquisition Mode, only the centre energy can be 
changed. 

6.4.3.8 Step 

The Step area defines the step time and step size of the region. 

 For detectors that have a fixed frame rate, such as digital cameras, both the Frames and 
the Time fields can be used to select the desired step time. The step time defines the 
amount of time the detector should spend acquiring data for each energy step. 

 For detectors with a fixed frame rate, the value in the Time field is always adjusted to 
define a whole number of frames. 
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 For swept mode acquisitions, the energy step defines the distance in energy between each 
point of the spectrum. The energy step in conjunction with the energy range defines the 
number of steps, and thus the number of spectrum points, of a swept mode acquisition. 

 The Step area displays frame rate for detectors with a fixed frame rate, minimum step 
time and minimum energy step for the selected pass energy. It also displays the total 
number of steps and estimated total time for one acquisition of the region. 

6.4.3.9 Detector 

The Detector area defines the detector settings for the region. 

 The Active Detectors field determines if acquisition should be made through the detector 
and/or the Signals I/O. 

 If the Use Region Defined Detector checkbox is unchecked, the region will use the global 
detector settings. 

 If the Use Region Defined Detector checkbox is checked, it will use local detector 
settings specific to the region. The local detector settings can be changed by clicking the 
Setup button. 

6.4.3.10 Excitation 

The Excitation Energy area defines the excitation energy or photon energy for the region. 

 An excitation energy can be entered either by selecting one of the predefined energies, or 
by typing a new value in the Excitation Energy field. 

 The predefined excitation energies and the default excitation energy for new regions can 

be modified in the Excitation Energies dialog, accessed by selecting Setup  Excitation 
Energies … from the SES menu bar. 

 If a monochromator plug-in is being used, the monochromator can be moved to the 
selected excitation energy by checking the Move Monochromator checkbox. To use the 
current photon energy of the monochromator as the excitation energy for the region, 
click the Get Energy button. 

6.5 Run Modes 

6.5.1 Description 

A run mode is a set of rules that defines how the SES should perform acquisitions and how it 
should save the data resulting from these acquisitions.  
 
SES comes with two built-in run modes; Normal and Add Dimension. Each of these run modes 
can be selected and configured for the whole sequence and for each region individually. Other 
run modes can be added manually by the user which is mostly done for external equipment 
control. Manipulator Scan, CIS and CFS are examples of such modes. 

6.5.1 Access 

Run modes are selected and configured in the Run Mode areas of the Sequence Editor and the 
Region Editor for the sequence and regions respectively. 
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6.5.2 Adding Run Modes 

A run mode is part of a user interface library that is installed by Setup  User Interfaces… 
from the SES menu bar (see section about user interfaces above). 

6.5.3 Global vs Local Run Modes 

When the run mode is selected in the Sequence Editor it is defined as “global”, and when it is 
selected for an individual region it is defined as “local”. 
 
It is recommended to use multiple sequence files when handling more than one global run mode. 
The integrity of the region settings will be protected that way.  
 
All combinations of global and local run modes are not allowed for logical reasons. For example 
it is not possible to run the following combinations: 

 A local CIS region in a global CFS sequence. 

 A local special manipulator region in a global manipulator scan sequence. 

 A local spin mapping region in a global DA30 ARPES mapping sequence. 

 
If a specific run mode is selected for a region, the non-matching run modes in the Sequence are 
made invisible for the user and vice versa. 

6.5.4 Normal and Add Dimension Run Modes 

The following points describe principles of normal and Add dimension run modes. 

 In the Normal run mode, consecutive acquisitions are summed together to yield higher 
intensity and a better signal to noise ratio. 

 In the Add Dimension run mode, each consecutive acquisition is stored separately to 
form an extra dimension in the experiment file. If both the sequence and a region make 
use of the Add Dimension run mode, the result will be two extra dimensions in the 
experiment file. 

 By selecting the Number of iterations option, the number of consecutive executions of 
the sequence or the region can be specified. 

 By selecting the Repeat until stopped option the execution of the sequence or the region 
can be repeated indefinitely. 

 If Confirm after each iteration is checked, a confirmation to continue will be displayed 
after each successful execution of the sequence or the region. 
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6.6 Special Regions 

A special region is part of a user interface and becomes available when a user interface is installed 

via Setup  User Interfaces…. (analogous to run modes). 
 
In contradiction to normal regions, the action of a special region is not bound to spectrum 
acquisition. Mostly they control external equipment or signal input/output in a spectrometer 
system. 
 
Move Manipulator and Move Monochromator are examples of special regions (see sections 
below). 

6.7 Sequence Execution 

 
The following steps describes how to start a measurement sequence of regions. Details can be 
found in the Sequence Editor section above. 

1. Open the Sequence Editor 

2. Create measurement regions if not already done. 

3. Edit energy range and other region parameters in the Region Editor. 

4. Change the file options if needed. 

5. Select the regions to be measured and start the acquisition. 
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7 OPERATIONS DURING ACQUISITION 

7.1 Introduction 

This section describes the operations and information during data acquisition. 

7.2 Spectrum Display Operation 

 

7.2.1 Description 

The main Spectrum Display window is used to display acquired spectra, and can be configured to 
display data in several ways. It scales data automatically during acquisition, and offers zooming 
capabilities as well as peak property presentation. 

7.2.2 Access 

The Spectrum Display is always present in the main window of SES. 

7.2.3 Display 

 

Figure 39: Spectrum Display view of the main SES window. 

 
Spectra are plotted during acquisition in the Spectrum Display view of the main SES window. By 
right clicking in the spectrum area, the Spectrum Display context menu is opened with the 
following options: 

 The Show Coordinates menu item specifies whether the information about the 
coordinates of the mouse pointer’s current position should be displayed. 

 The Integrate Slices menu item is only available with multiple slice spectra. If Integrate 
Slices is checked, the spectrum data for all slices will be summed and displayed as a single 
slice spectrum. 

 The Show Spectrum Image menu item is only available with multiple slice spectra. If 
Show Spectrum Image is checked, the spectrum data will be displayed as an image 
representation of the spectrum. 



 

 

SES Software Manual v5.0  Copyright ©2018 Scienta Omicron AB 

56 

 The Use Range Markers menu item specifies whether only data within the area of the 
range markers should be displayed. 

 The Show Peak Information item enables/disables the Peak Information bar at the 
bottom of the spectrum display. 

 The C1s menu item is named after the region that is being displayed, and is only visible if 
the spectrum has as a graph. Its sub menu specifies whether the graph should be drawn 
using lines or points as well as the colour of the graph. The sub menu also allows more 
detailed modification of the curve by opening a Customize dialog. 

 The Colour Scheme item specifies what colours to use for the background of the 
spectrum display, as well as for the axes and the text. When selecting a colour scheme, the 
colour of the graph will be reset to the default value for that colour scheme. 

 
Note: The Integrate Slices and Show Spectrum Image commands are mutually exclusive. By 
checking either one of them, the other will automatically be unchecked. If either one of them is 
checked the Slice option will not be visible. 

7.2.4 Customize Curves 

7.2.4.1 Description 

The Customize Curves dialog lets the user modify how the spectra are displayed. 

7.2.4.2 Access 

From the context menu in the Spectrum Display, select Customize… 

7.2.4.3 Dialog 

 

Figure 40: The Customize Curve dialog. 

 By checking the Draw Line and/or Draw Point checkboxes, the curve can be visible in 
different forms and colors. 

 The curve can be drawn with Solid, Dash, Dot, Dash-Dot and Dash-Dot-Dot shapes, 
and the color can be selected by clicking on the color box. 

 The individual points can be shown as Points, Squares, Diamonds, Circles or Crosses. 
The size of the points is also adjustable through the Size text field. The Size and Fill 
attributes are not applicable for Point shapes, which only draw individual pixels. The 
color can be selected by clicking on the color box. 
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7.2.5 Displaying Spectra as Images 

 

Figure 41: Image representation of a multiple slice spectrum. 

When displaying the spectrum image, the Scale Factor field will be visible. The scale factor 
specifies how the body of the spectrum data should be scaled with respect to the maximum. 

 Decreasing the Scale Factor yields more detail in the low intensity areas of the spectrum, 
such as noise. 

 Increasing the Scale Factor yields more detail in the high intensity areas of the spectrum. 
 
If the Show Coordinates item is checked, in addition to the position of the mouse pointer, the 
intensity of that position will also be displayed. 
 
Note: When a large detector area with many slices is selected, the sweep speed might be 
decreased due to parallel tasks and limited computer performance. For optimal performance, do 
not display the spectrum in image mode when acquiring swept spectra. Note however that the 
data is acquired correctly in any case. 

7.2.6 Displaying Signals 

Signals are treated as detectors without spatial dimensions. For fixed mode acquisitions the signal 
data will consist of one value for each channel, whereas for swept mode acquisitions there will be 
one curve for each channel. 
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7.2.6.1 Displaying Signals in Swept Mode 

 

Figure 42: Spectrum display showing signal data from a swept mode acquisition. 

For swept mode acquisitions, each channel is displayed as an individual curve in a separate 
spectrum display. The x-axis represents Kinetic Energy and the y-axis the measured channel 
values. Each channel has individually configurable colour and drawing configurations. 

7.2.6.2 Displaying Signals in Fixed Mode 

 

 

Figure 43: Display showing signal data from a fixed mode acquisition. 

For fixed mode acquisitions, each channel is displayed as a value and a bar. The sum of all 
channels is also shown in the Total Count field. 
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7.2.7 Displaying Signals and Spectrum Simultaneously 

 

Figure 44: Signal and spectrum data from a swept mode acquisition. 

For swept mode acquisitions, signal and spectrum data are displayed in separate spectrum 
displays. If the Correlate scales for signals and detector option is checked in the SES Options 
dialog, the energy scales for the signal and spectrum data are correlated. 
 

 

Figure 45: Signal and spectrum data from a fixed mode acquisition. 

For fixed mode acquisitions, spectrum data is displayed in a spectrum display and signal data in a 
signal display. 

7.2.8 Spectrum Normalization 

 

Figure 46: Spectrum plot menu as shown when using both detector and signals. 
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When both detector and signals are acquired simultaneously in swept mode, options for 
normalizing the spectrum to the acquired signals are added to the plot menu. 
 
It is also possible to view the signals in the same plot as the spectrum. 

7.2.9 Spectrum Markers 

 

Figure 47: Range markers and Peak Information bar enabled. 

7.2.9.1 Range Markers 

The range markers are used to specify which energy range of the spectrum should be displayed 
and used for calculation of peak information. If a spectrum contains multiple peaks, peak 
information pertaining only to the highest peak is displayed.  
Information about another peak can be gained by moving the range markers to include only that 
peak. By moving the range markers to include a certain region of interest, the area is calculated 
using data within the range markers only. 

7.2.9.2 Peak Information 

The properties given on the Peak Information bar at the bottom of the spectrum display are 
described in the table below. These values can be used in real time when optimizing intensity and 
resolution for desired analyser settings. 

Table 10: Peak information. 

Property Description 

Position Energy at the peak centre. 

Height Intensity at the top of the peak. 

FWHM Full width of the peak at half of the maximum intensity. 

Area The total intensity of the whole spectrum window. 
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7.2.9.3 Background Removal 

 

Figure 48. The menu for background removal of the displayed spectrum. 

The spectrum display can be modified through background removal of the acquired spectrum. 
This is done through right-clicking on the spectrum display and selecting which background 
shape to use. Available shapes are None, Linear or Shirley. This visualization is only applied to 
the current display, and will not be stored in the result file. 

7.3 Sequence Tree 

7.3.1 Description 

The sequence tree keeps track of produced spectra during and after acquisition. 

7.3.2 During Acquisition 

 

Figure 49: Sequence tree during acquisition. 

 
During acquisition the tree contains a list of all regions enabled for the acquisition, and displays 
icons whose colours specify the status of the region. 

 If the icon is red, the region is currently being executed. 

 If the icon is white, region has not yet been executed or there is no data to save. 

 If the icon is green, the region has successfully been acquired and data has been saved. 
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7.3.3 After Acquisition 

 

Figure 50: Sequence tree after acquisition. 

 
After acquisition the spectra of the individual regions can be displayed by selecting the region in 
the sequence tree. If the Add Dimension run mode is used, the individual spectra of the region 
can be displayed by selecting the relevant iteration count. 

7.4 Acquisition Status Bar 

7.4.1 Description 

The Acquisition Status Bar of the SES main window displays information pertaining to the 
current acquisition. Depending on which options are selected in the Appearance tab of the 
Options dialog, the appearance of the status bar will be different. 

7.4.2 Status Bar 

 

Figure 51: The Acquisition Status bar of the SES main window. 

 
The information shown in the status bar, from left: 

 The current and total number of additive iterations of the region. 

 The name of the experiment file in which spectrum data is saved. If the Autosave option 
in the File Options dialog is unchecked, the text “No Autosave.” will be displayed. 

 The name of the temporary file where the acquired data is saved as long as the spectrum 
is shown in the Spectrum Display plot. 

 The Lens Mode and Pass Energy of the acquisition. 

 The current Kinetic Energy of the analyser during acquisition. 

 The estimated remaining time of the acquisition. 
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8 INSTALLATION 

8.1 Introduction 

This section describes the installation procedures used for the initial setup of a new system. 

8.2 Instrument Installation 

8.2.1 Description 

The Instrument Installation dialog is used to change basic settings of the instrument, such as 
which detector and supply libraries to use. 

8.2.2 Access 

From the Installation menu on the SES menu bar, select the Instrument item. (Installation  
Instrument...) 

8.2.3 Dialog 

 

Figure 52: The Instrument Installation dialog. 

Note: The Instrument Installation dialog should only be used by the system administrator. 
 

 The Model and Serial Number fields specify the model and serial number of the 
instrument. 

 The AV Delay specifies the delay used when the voltage of a high voltage supply is 
changed. The Region Delay specifies the delay used between the regions in a sequence. 
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 The Detector Interface area specifies which detector library to use for data acquisition. 
To change library, click the Browse button and to change library settings, click the Setup 
button. 

 The Supply Interface area specifies which supply library to use to control the HV 
supplies. To change library, click the Browse button and to change library settings, click 
the Setup button. 

 The I/O Interface area specifies which I/O library to use for external I/O 
communication. To change library, click the Browse button and to change library settings, 
click the Setup button. 

 The Configure as Spin Detector checkbox enables the External I/O interface to be used 
specifically for spin detectors. 

 
Note: Shipped with SES come dummy libraries for each interface. They are named 
Detector_Dummy.dll, Supply_Dummy.dll and ExternalIO_NIDAQ_Dummy.dll respectively. 

8.2.4 Configuring the I/O Interface as Spin Detector 

8.2.5 Description 

Multiple spin detectors can be installed and configured in the External Detector Installation 
dialog. 

8.2.6 Access 

From the I/O Interface area in the Instrument Installation dialog, check the Configure as Spin 

Detector checkbox and click on the Setup Detector button. (Installation  Instrument...  
Setup Detector…) 

8.2.1 Dialog 

 

 

Figure 53: The External Detector Installation dialog for spin detector setup. 
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Each added tab represents one spin detector, and each spin detector can be configured with 
different channels (Input Signals). Once a channel has been selected for one tab, that channel is 
disabled for the other tabs. 

8.3 Supply Installation 

8.3.1 Description 

The Supply Installation dialog is used to add and remove supplies, and to change their settings 
and calibration parameters. 

8.3.2 Access 

From the Installation menu on the SES menu bar, select the Supplies item. (Installation  
Supplies…) 

8.3.3 Dialog 

 

Figure 54: The Supply Installation dialog. 

Note: The Supply Installation dialog should only be used only by the system administrator. 
 

 The supply list displays the supplies for the instrument. By selecting one specific supply, 
its calibration parameters and settings can be edited. 

 New supplies can be added by selecting the proper type and clicking the Add button. By 
clicking the Delete button, the selected supply is deleted. The calibration curve for a DAC 
can be viewed by selecting it in the supply list, and clicking the Calibrate button. 

 The DAC Calibration field specifies which DAC calibration-file is used. A new DAC 
calibration-file can be selected using the Browse button, and loaded using the Load 
button. 
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 Settings for all supplies and the calibration parameters for high voltage supplies can be 
exported and imported using the Import and Export commands from the File menu 

under the SES menu bar respectively. (File  Export, File  Import) 

 The Ramp Step and Ramp Delay settings are set to allow individual supply voltages to 
ramp up to the desired voltage with a delay (given in ms) between each step (given in V). 

8.3.4 DAC Calibration File Format 

The text file DAC.ini contains the DAC board calibration points describing the output voltage of 
each DAC with respect to the software set value. 
If a DAC board is replaced in the high voltage cabinet, the corresponding calibration data has to 
be replaced in the DAC.ini file. The format of the file including two DAC boards is illustrated in 
an example below. 
 
[ID 1] 

Number of Points=51 

Step 1=-63000 

Voltage 1=-12.60464 

Step 2=-60480 

Voltage 2=-12.100773 

. 

. 

Step 50=60480 

Voltage 50=12.100837 

Step 51=63000 

Voltage 51=12.604755 

[ID 2] 

Number of Points=51 

Step 1=-63000 

Voltage 1=-12.60452 

Step 2=-60480 

Voltage 2=-12.100406 

. 

. 

Step 50=60480 

Voltage 50=12.100476 

Step 51=63000 

Voltage 51=12.604624 

 

8.4 Element Installation 

8.4.1 Description 

The Element Installation dialog is used to add and remove element sets, add and remove 
elements in the element sets, link supplies to elements and link elements to each other. 

8.4.2 Access 

From the Installation menu on the SES menu bar, select the Elements item. (Installation  
Elements…) 
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8.4.3 Dialog 

 

Figure 55: The Element Installation dialog. 

Note: The Element Installation dialog should only be used only by the system administrator. 
 

 The tabs of the dialog specify the different element sets available to the instrument. 

 The Fix Elements area defines elements which are neither dependent on pass energy nor 
kinetic energy. 

 The Pass Elements area defines elements which are dependent on pass energy, but not 
kinetic energy. 

 The Kinetic Elements area defines elements which are dependent on both pass energy 
and kinetic energy. 

 Acceleration Element area defines the acceleration element. 

8.4.4 Modifying Elements and Element Sets 

Elements in all the different areas described above can be: 

 Added by clicking the Add button. 

 Deleted or renamed by clicking the Delete or Rename buttons. 
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 Linked to an element further up in the list by clicking the Link button. 

 The supplies linked to an element can be changed by clicking the Supplies button. 

 The association for an element can be changed using the Associations drop-down list. 
Available values are Analyser Element, Detector Element or External I/O Element. 

 The security level for an element can be changed using the Security Level drop-down list. 
Available values are Administrator, Privileged User and User, where Administrator is the 
highest level. 

 Element sets can be added, deleted or renamed by clicking the corresponding buttons in 
the Element Set area. 

 
Note: Associations are important when using an instrument which has both signals and a 
detector, and where elements associated with each input interface should be turned off when that 
interface is not used. 

8.5 Lens Mode Installation 

8.5.1 Description 

The Lens Mode dialog is used to add and remove lens modes and to add and remove pass 
energies. 

8.5.2 Access 

From the Installation menu on the SES menu bar, select the Lens Modes item. (Installation  
Lens Modes...) 

8.5.3 Dialog 

 

Figure 56: The Lens Mode Installation dialog. 
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Note: The Lens Mode Installation should only be used by the system administrator. 
 
Note: For the first lens mode, all pass energies must be activated. 
 

 Lens modes can be added by clicking the Add button in the Lens Mode area. The 
selected lens mode can be deleted or renamed by clicking the Delete or Rename button 
respectively. 

 The Y-Scale Unit field specifies the dimensional unit used for the angular or spatial 
dimension. 

 The check list in the Pass Energies area specifies the available pass energies for the 
selected lens mode. Pass energies can be added by clicking the Add button and the 
selected pass energy can be deleted by clicking the Delete button. For specific lens 
modes, a pass energy can be activated or deactivated by checking the corresponding 
checkbox in the list. 

 The Magnification/Dispersion field specifies the dispersion for angular lens modes and 
the magnification for spatial lens modes for the selected pass energy. The Offset field 
specifies the angular or spatial scale offset for angular and spatial lens modes respectively 
for the selected pass energy. 

8.6 Application Examples 

8.6.1 Installing a New HV Supply 

In addition to installation of a new HV supply in the rack, the supply has to be defined in the 
SES software. 
The following steps should be performed: 

1. Identify a free optical output (marked with a plain numeric ID) on the DOM board in the 
rack. Make a note of the ID number. 

2. Start SES and add a new supply in the Supply Installation dialog. Select “HV” from the 
drop-down menu. Enter the selected ID number. 

3. Read the A and B calibration parameters that are printed on the HV Supply hardware and 
enter them into the Supply Installation dialog. 
 
A is the Offset value in millivolts 
B is the Max Output value in Volts 
 
Note: Offset and Max Output in the Supply Installation dialog are both given in Volts. 

4. Enter the other parameters for the supply. Period, Ramp Step and Ramp Delay can be 
copied from other supplies but Max Lim and Min Lim are unique for the new supply 
since they define the operating voltage range. 

5. Close the dialog and save the data by clicking the Save button when asked to. 

6. Install the HV supply in the rack and connect it with a fibre to the selected optical output 
of the DOM board. 
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8.6.2 Installing a New DAC Board 

In addition to installation of a new DAC board in the rack, the DAC has to be defined in the 
SES software. 
The following steps should be performed: 

1. Identify a free optical output (marked with the letter “D” and a numeric ID) on the 
DOM board in the rack. Make a note of the ID. 

2. Set the 8-bit dip switch on the DAC board to the selected ID number in binary format. 
Switch 1-8 correspond to bits 0-7, and the ON state corresponds to a logical “1”. 
 
For example: ON, OFF, ON, OFF, OFF, OFF, OFF, OFF corresponds to 00000101 
which represents ID = 5. 

3. Check that a DAC calibration data file is available for the new DAC. 

4. Start SES and add a new DAC in the Supply Installation dialog. Select “DAC20” from 
the drop down menu. Enter the selected ID. 

5. Enter the other parameters for the DAC. They can all be copied from other DAC boards 
in the list. 

6. Make a note of the path and file name of the current DAC.ini file that is stated in the 
bottom of the dialog. 

7. Close the dialog and save the data by clicking the Save button when asked to. 

8. Exit SES and open the DAC ini file as well as the new DAC calibration data file. Copy 
the new calibration data into the DAC ini file and save it 

9. Install the new DAC in the rack and connect it with a fibre to the selected optical output 
of the DOM board. 

8.6.3 Double HV Rack Configurations 

A DOM (Digital Output Module) board in a HV rack is able to address 16 DAC cards and 32 
HV supplies. If this is not enough, additional DOM boards have to be installed, either in the 
same rack or in additional racks that share the same communication line to the PC. 
Each DOM board is given a base address plus a 5 bit address space. This space of 32 addresses 
(i.e. board ID numbers) can be used for DAC’s as well as HV supplies since these two types of 
boards are controlled by two different command types from SES. Hence, there is no conflict 
addressing a DAC and a HV supply with identical ID’s. 
The DOM board has a four bit jumper area where the base address of the board is programmed. 
The two middle jumpers are mapped to the middle bits of the high nibble of the board ID in 
SES. The first DOM board with base address 0 should have jumper setting x00x. The second one 
at base address 32 should have x01x. The third one at base address 64 should have x10x and so 
on (0 means jumper present, 1 means jumper removed, x means jumper for other functionality). 
More details about the jumper settings can be found in the Scienta Supply Protocol manual. 

8.6.4 Extra Acceleration Voltage Chain 

In some cases, such as spin detector applications, a large number of HV cards on the detector 
side have to be biased on the Herzog (i.e. acceleration) voltage. In order to reduce the load on the 
accelerating chain supplies, and to minimize the risk for crosstalk between the analyser and the 
detector parts, a copy of the accelerating chain can be installed in parallel to the real Herzog 
voltage. 



 

 

SES Software Manual v5.0  Copyright ©2018 Scienta Omicron AB 

71 

 
The following steps should be performed in order to install two HV supplies that bias the spin 
detector to the same potential as the Herzog plate. 

1. Add two HV supplies to the rack and configure the spin detector filterbox in a way that 
the spin detector is biased to the sum of the supplies (that are denoted SAV- and SAV + 
in this text). The voltage ranges and polarities should be selected to match the specific 
analyser energy range. These operations are part of production and service work at 
Scienta Omicron and should not be performed by normal SES users. 

2. Define the HV supplies in SES according to previous section. 

3. Open the Element Installation dialog and add a new “Kinetic” element (named SAV in 
this example). 

4. Inspect the Accelerating chain supply configuration in the dialog and associate the same 
set of supplies to the SAV element but with opposite sign. Then add SAV+ and SAV- 
supplies to the SAV association list. 
 
For example: If the Accelerating element has the following configuration: 
 
Offset + Ep Offset + AVScan + (AV+) – (AV-) 

 

SAV should have following configuration: 
 
- AVScan - (AV+) + (AV-) + (SAV+) – (SAV-) 

 
Close the dialog and save the data by clicking the Save button when asked to. 

5. Open the Lens Table Editor from the Calibration Voltage dialog. The table for SAV 
should be just two entries long. Enter (0, 0) and (Max, 0) where Max stands for the 
highest kinetic energy that will be measured. The settings above makes SAV to act as a 
virtual element at zero Volts, forcing the SAV supply chain voltage to be equal to the 
Herzog chain voltage. 

6. Create identical tables for all pass energies that will be used. Close the dialog and save the 
data by clicking the Save button when asked to. 

7. Turn on the HV rack and play with the pass energies and kinetic energies using the 
Voltage Calibration dialog. Check that the voltage supply settings behave as predicted in 
the Supply Information window. 

8. Measure with a high voltage probe and a multi-meter on the filterbox electrodes and 
confirm that the Herzog voltage and the SAV voltage follow each other. 
 
Note: No DAC board is included in the SAV chain in this example which means that the 
voltage steps of SAV becomes larger than the steps of the real Herzog voltage. 

8.6.5 Kinetic Energy Output as a Voltage 

In some cases, add-on equipment to the analyser needs information about the measured kinetic 
energy in real time. This can be communicated as an analog voltage from the HV rack. 
In the following example a DAC is employed for generation of a voltage that is proportional to 
the measured kinetic energy, but a HV Supply could be used as well. Only the calibration routines 
differ. 
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Warning: Always use a high voltage probe with high impedance when measuring the voltage 
output from the spectrometer cabinet. This work must be done by trained and authorized 
personnel only. 
 

1. Install a new DAC in the rack and define it in SES according to previous section. 

2. Restart SES and define a new “Kinetic” element in the Element Installation dialog and 
associate it to the new DAC via the corresponding Supplies button. 

3. Open the Lens Table Editor from the Calibration Voltage dialog and enter the table for 
the new DAC. It should contain just two entries representing a straight line between (0, 
0) and (Max Ek, Max V) where Max V is the voltage that should be output at a certain 
kinetic energy Max Ek.  
 
For example: If 5V output should correspond to Ek = 1keV, the table should have the 
following entries: (0, 0), (1000, 5). 
 
This type of table makes the DAC output proportional to the measured kinetic energy 
but other relations can easily be implemented by just extending the table. 

4. Create identical tables for all pass energies that will be used. Close the dialog and save the 
data by clicking the Save button when asked to. 

5. Turn on the HV rack and play with the pass energies and kinetic energies using the 
Voltage Calibration dialog. Check that the DAC setting behave as predicted in the Supply 
Information window. 

6. Measure the DAC output with a voltmeter and a high voltage probe. Confirm that the 
voltage is proportional to the kinetic energy as required. 
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9 OPTIONS 

9.1 Introduction 

This section describes how to customize the software overall behaviour. 

9.2 SES Options 

9.2.1 Description 

The SES Options dialog is used to define general aspects of appearance and behaviour of the 
SES software. An important option in the Acquisition tab is the choice to zero all supplies after a 
completed acquisition. This is important when working with experiments that might expose the 
detector to hazardous countrates. 

9.2.2 Access 

From the File menu on the SES menu bar, select the Options items. (File  Options…) 

9.2.3 Messages Tab 

 

Figure 57: The Message tab of the SES Options dialog. 

Note: The Messages tab should only be used by the system administrator. 
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9.2.4 Appearance Tab 

 

Figure 58: The Appearance tab of the SES Options dialog. 

The Appearance tab contains general options for the appearance of the SES software. The 
administrator will setup these options. 

 If the Expand sequence tree view option is checked, acquisitions using the Add 
Dimension run mode will be expanded automatically in the sequence tree view. 

 If the Show name of… option is checked, the name of the temporary file stored in the 
work folder will be displayed in the status bar. This option is for advanced use. 

 If the Show Kinetic Energy… option is checked, the current kinetic energy of the 
analyser is displayed in the status bar during acquisition. 

 If the Show Lens Mode… option is checked, the current lens mode and pass energy is 
displayed in the status bar during acquisition. 

 If the Show Progress Bar option is checked, the progress bar for swept modes is 
displayed below the spectrum display during acquisitions. 

 If the Correlate Scales… option is checked, spectrum displays showing signal and 
detector data will use the same energy scale. 
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9.2.5 Acquisition Tab 

 

Figure 59: The Acquisition tab of the SES Options dialog. 

The Acquisition tab contains options pertaining to acquisitions, and applies to the setup and 
calibration dialogs that have acquisition capabilities as well as experiment acquisitions. The 
administrator will setup these options. 

 If the Always use delay … option is checked, a region delay of usually one second will 
always precede the execution of an acquisition even if the high voltage power supplies 
have not changed since the last acquisition. 

 If the Zero voltages… option is checked, all supplies will be zeroed when a sequence is 
completed or stopped by the user, and when a calibration or setup dialog with acquisition 
capabilities is closed. 

 If the Allow acquisitions… option is checked, acquisitions using the detector and signals 
simultaneously are possible. 

 If the Use multiple sequences option is checked, the Sequence List Editor is available 
through clicking the Setup item from the Sequence menu. 

 
Note: It is highly recommended that the Zero voltages… option remains checked at all times, to 
minimize the risks of detector overload. 
 
Note: If the detector and signals operate on disparate intensity levels, checking the Allow 
acquisitions… option increases the risk for a detector overload by allowing users to use detector 
and signals simultaneously. 
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9.2.6 Spectrum Correlation Tab 

 

Figure 60: The Spectrum Correlation tab of the SES Options dialog. 

The Spectrum Correlation tab contains options pertaining to spectrum correlation. When 
calibrating the detector, correlation is performed using Fast Fourier Transform routines for both 
XPS and UPS peaks, and Fermi edges. See more about detector calibration in the Calibration 
chapter. 

 If the Peak option is selected, the spectra in the Detector Calibration dialog will be 
assumed to contain an XPS or a UPS peak. 

 If the Fermi edge option is selected, the spectra in the Detector Calibration dialog will be 
assumed to contain a well, defined cut-off edge. 

 Prior to correlation, the spectrum data is smoothed and differentiated once using a 
Savitzky-Golay filter. The number of smooth points can be specified using the Smooth 
Points field. 
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9.2.7 Spectrum Display Tab 

 

Figure 61: The Spectrum Display tab of the SES Options dialog. 

The Spectrum Display tab contains options pertaining to displaying spectra and in particular to 
displaying of image representations of spectra. 

 If the Spectrum Image… option is checked, the image representation of a multiple slice 
acquisition will be displayed in an external window. 

 If the Delay drawing… option is checked, the spectrum display in the SES main window 
delays displaying of an acquisition until data is available. This allows a completed 
spectrum to be viewed while the subsequent acquisition performs its preparation steps. 

 The Image Scale Factor area pertains to the external image in the SES main window and 
in the Voltage Calibration dialog. 

 If the Update on the fly option is checked, changes to the scale factor will take effect 
immediately. 
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10 MONITORS 

10.1 Introduction 

This section describes how information about the actual supplies and detector settings is 
monitored for the user. 

10.2 Supply Information Window 

10.2.1 Description 

The Supply Information window is used to display the voltages output from all supplies during 
instrument operation. This window is mainly used for troubleshooting (e.g. to check whether 
certain instrument settings brings any of the supplies out of range). 

10.2.2 Access 

From the View menu on the SES menu bar, select the Show Supply Information command. 

(View  Show Supply Information…) 

10.2.3 Supply Information Window 

 

Figure 62: The Supply Information window. 

The supply voltage indicators can be dragged and dropped to resemble the layout of the high 
voltage cabinet. If a supply is within its operational range, this is indicated by the green colour of 
the numbers in the voltage indicator. If not, this is indicated by the red colour. 

10.3 Detector Information Window 

10.3.1 Description 

The Detector Information window is used to display the current detector settings. This dialog 
can be used to verify that the correct detector settings for different regions in a sequence are 
selected. 
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10.3.2 Access 

From the View menu on the SES menu bar, select the Show Detector Information command. 

(View  Show Detector Information…) 

10.3.3 Detector Information Window 

 

Figure 63: The Detector Information window. 
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11 MANIPULATOR 

11.1 Introduction 

This section describes how to operate a manipulator user interface in SES, how to install the 
software and how to test the functionality. Manipulator control requires a general manipulator 
library but also a hardware dependent plug-in library. All examples are given for the McLennan 
SimStep stepper motor controllers but the principles apply to all brands of controllers. 

11.2 Installation 

11.2.1 Connecting the Controller 

The PC should be connected to the manipulator controller hardware prior to software 
installation. The SimStep stepper controllers operate through a standard RS232 protocol, and in 
this case the controller should be connected via a serial (COM) port. Other controllers employ 
GPIB, Ethernet, or USB for example. 

11.2.2 Adding the General Manipulator Library 

The general manipulator library is installed by adding the Manipulator.dll in the list of user 

interfaces under Setup  User Interfaces… from the SES menu bar (see section about user 
interfaces above). 
Once the Manipulator.dll library has been added to the list, the Manipulator menu appears on the 
SES menu bar. 

11.2.3 Adding the Hardware Dependent Plug-in Library 

While the general manipulator library is a control library for all types of manipulators, the 
hardware dependent plug-in handles the communication with specific hardware. The following 
steps should be taken to install the ManiHW_SimStep.dll library for the SimStep controllers. 

1. Select the Manipulator.dll file and click the Setup... button in the User Interfaces dialog, 

or select Manipulator  Setup… from the SES menu bar. The Setup Manipulator 
dialog is opened by both actions. 

2. Click the Browse button and select the ManiHW_SimStep.dll library. The dialog is shown 
below. 

 

 

Figure 64: The Setup Manipulator dialog. 
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 When the Continue Acquisition on Error checkbox is checked, the acquisition will 
continue even when the manipulator has stopped due to an error. 

 

Figure 65: The Manipulator Position dialog. 

 The Manipulator Position Dialog will be opened whenever any axis passes the threshold 
value given in the Movement Dialog Threshold field. If set to 0, the dialog will always be 
opened. 

 If the Manipulator Position dialog has been opened during manipulator movement, 
checking the Close Dialog after Completed Movement checkbox will cause it to 
automatically close when the movement is completed. 

 When the Show Large Manipulator Positions checkbox is checked, a dialog with the 
manipulator positions will be shown alongside the Manipulator Position dialog. The font 
size in this dialog is considerably larger than the font in the Manipulator Position dialog. 
The font size also scales with the dialog window size. 

11.3 Setup 

11.3.1 Axes Settings 

All axes of the manipulator and their individual parameters have to be defined for the specific 
hardware used. The dialogs and parameter sets can be different from one hardware plug-in library 
to another, but the basic principles are the same. 
 
This section describes how to setup the axes in the ManiHW_SimStep.dll library. 

 In the Setup Manipulator dialog, click the Setup... button to open the Axis Settings dialog. 
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Figure 66: The Axis Settings dialog. 

 Select the serial port that is connected to the manipulator controller from the Port 
selection field in the Communication area. 

 Click the Setup... button for the selected serial port to modify the settings. This defaults 
to 9600 bits/s, 7 data bits, Even parity, 1 Stop bit and No Flow Control for many stage 
controllers. 

 Add the wanted number of axes by clicking on the Add Axis button. The axis parameters 
are described below. 

Scale Factor: The number of motor steps per given unit. 

Low/High Limit: The soft limits for axis motion. 

Home Position: When the axis is initialized with a Home Sensor, the axis position will 
be set to this value when the Home Sensor is reached. 

Unit: Arbitrary unit for the axis (typically mm, degrees, etc.). 

Back Off: This setting can be used to ensure that the axis always arrives at a position 
from the same direction. It is specified in number of steps and the value can be negative 
or positive depending on the desired direction.  

Slew Speed: Maximum speed in steps/second. The slew speed can range between 1 and 
1 200 000 steps/second. 
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Creep Speed: The last steps at the end of a move will be moved with this speed, 
specified in steps/second. Creep Speed can either be ranged between 1 to 400.000 in 
servo modes and 1 to 800 in stepper modes. Creep Speed must also be equal or less than 
Slew Speed. 

Creep Steps: The number of steps at the end of a move that will be moved with the 
Creep speed. 

Mode: The mode which the manipulator will run in. Refer to the PM600 Motion 
Controller User Manual for further information. 

Home Sensor: Check this checkbox if the manipulator has physical limit sensors. If so, 
the motor controller can perform a "home" maneuver when the Init button is pressed 
later in the Control Manipulator dialog. Note however that the way to do homing is 
programmed in the motor controller and not in the SES software. 

Rotation Axis: Check this checkbox if the axis is used for rotational motion. This 
information is used when grouping the axes (rotational/linear) in other parts of the 
software. In addition, the number of digits for rotational positioning is less than that for 
linear motion. 

Soft Initialization: When pressing the Init button in the Control Manipulator dialog 
while Soft Initialization is active, the user can specify a position which the current axis 
position will be set to.  

Initialization in Positive Direction: When checked and while using a Home Sensor the 
axis initialization will be performed in positive direction, otherwise in negative direction. 

Reverse Movement Direction: When this checkbox is checked the axis movement 
direction will be reversed. 

11.3.2 Predefined Positions 

It is possible to define a list of positions and give them specific names. This is especially useful 
for manipulators with multiple axes that need to return to a previously visited position. 

 Open the Edit Positions dialog by selecting Manipulator  Edit Positions… under 
the SES menu bar. 

 

Figure 67: The Edit Positions dialog. 

 Click New to create a new position. The name of the position can be modified at any 
time by clicking on Rename. 
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 Click Read Position to read the current position. This will update the values of all 
involved axes. 

 Edit the position information for the available axes. To test the new position, click 
Move. 

 Close the dialog with Ok to accept the changes. 

11.4 Operation 

11.4.1 Manipulator Menu 

The manipulator user interface creates the Manipulator menu on the SES menu bar. 
 

 

Figure 68: The Manipulator menu. 

 Setup... opens the Setup Manipulator dialog for selection of hardware plug-in library 
and axis parameter setup. 

 Manual Control... gives access to the Control Manipulator dialog for manual tests of 
manipulator motion. 

 Edit Positions... opens the Edit Positions dialog for creation of pre-defined positions. 

 Show Position.. opens the Manipulator Position window for current position 
monitoring. 

 Default is the default pre-defined position. Additional pre-defined positions will show 
up in the menu below Default. The manipulator moves to a pre-defined position if 
the user selects it from the menu. 

11.4.2 Manipulator Scan Run Mode 

Point-to-point and two dimensional raster scans can be performed using the Manipulator Scan 
run mode. This mode should not be run together with Move Manipulator special regions since 
the manipulator motion is not meant to be controlled from two different sources (global and 
local settings would in such case interfere and cause strange behaviour). 
 
By selecting Manipulator Scan run mode in the Sequence Editor and clicking the Edit button, the 
Manipulator Scan Editor opens. The manipulator motion is defined by the settings of this dialog. 
Two different examples are illustrated below 
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Figure 69: The Manipulator Scan Editor settings in a point-to-point scan. 

The manipulator in the example above is supposed to move in 4 steps between two positions in a 
two-dimensional space, (5, 10) and (20, 70). The axes are named X-Axis and Y-Axis and they 
have to be non-rotating axes. 
 
The four positions are seen in the dialog together with the corresponding scale points that are 
automatically calculated from the resultant vector of the two axes motion. 
 
If Use Calculated Scale is not checked, the user can define an arbitrary scale. For example, if Scale 
Start was set to -3 and Scale Stop was set to 3 in the example, the scale points would have been -
3, -1, 1, 3. 
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Figure 70: The Manipulator Scan Editor settings in a dual scan loop. 
The inner loop has 4 steps and the outer loop has 3 steps. 

The manipulator in the example above is supposed to cover a map of 4x3 positions in a two-
dimensional space with the lower left corner at (5, 10) and the upper right corner at (20, 70). 
The axes are named X-Axis and Y-Axis and they have to be non-rotating axes. 
 
All positions are available in the dialog together with the corresponding scale points. 

 The Start and Stop columns define the start and stop positions of all axes that have been 

defined in the Axis Setup dialog under Manipulator  Setup from the SES menu bar. 
The positions are given in the units defined in the Axis Setup dialog. 

 The Major column defines whether the axes are major or minor. The spectrum data in the 
output file is plotted on a scale that is proportional to the major axes motion. A minor 
axis acts more like a slave, it has the ability to move during the scan but the positions are 
not reflected in the spectrum data. A typical use of minor axes is when the sample holder 
position has to be moved transversely in order to keep the sample spot position constant 
during sample rotation. 

 The Loop column defines whether the Major axes follow the inner or outer loop in a dual 
scan loop (i.e. a two-dimensional raster scan). During a dual scan loop, the outer loop axis 
takes one step for each full stroke of the inner loop axis. For minor axes this column has 
no meaning and the cell is blank. 

 The Scale row defines that start and stop value of the scale in the spectrum data file. If 
the scale is calculated by the program (see below), or in dual scan loop operation, this row 
cannot be changed manually. 

 The Dual Scan Loop checkbox in the Mode area enables dual scan loop operation. 
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 The Steps field in the Settings area of the Manipulator Scan Editor defines the number of 
steps (or positions) along the major axes. In the case of dual scan loop operation, each 
loop has individual number of steps. In a point-to-point operation there is only one step 
value. 

 Scale Unit is the unit that is written into the spectrum data file. 

 If Use Calculated Scale is checked, the scale is automatically adjusted to follow the major 
axes settings. The start and stop values of the scale that are entered manually in the Axis 
area are then overwritten. 

 If Calculate Linear Positions button is clicked, the positions between the start and stop 
values are interpolated to equidistant values. This is however also done when the start and 
stop values are changed. 

11.4.3 Move Manipulator Special Regions 

A Move Manipulator special region is created in the following way: 

1. Make sure that the manipulator user interface is installed successfully. 

2. Select Move Manipulator in the Special Region field of the Sequence Editor. 

3. Click the corresponding New button that will add the special region to the sequence list 
and open the Region Editor. 

4. Fill in the wanted manipulator position for each axis in the Region Editor. 

5. If a pre-defined position is wanted select it from the Position drop-down list. 

6. If the current manipulator position is wanted, click the Get Position button. 

 

 

Figure 71: The Region Editor for the Move Manipulator special region. 

When a Move Manipulator special region is defined in the sequence list, the manipulator will 
move to a specific position when the region is executed along with other types of regions in the 
list. 
 
Note: Move Manipulator special regions should not be combined with the Manipulator Scan run 
mode. That would mix local and global settings and cause strange behaviour. 
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11.4.4 Manual Control 

In order to verify that the settings are OK and that the manipulator moves in a controlled 

manner, the Control Manipulator dialog should be used. It is accessed from Manipulator  
Manual Control… from the SES menu bar. 

 

 

Figure 72: The Control Manipulator dialog. 

 Before any movements can be made reliably, the Init button should be clicked. 

 If the Move Immediately checkbox is checked, changes to any axis will result in 
immediate response from the manipulator. If this behavior is not desired (i.e. the 
manipulator is not allowed to move until all axes have been set up with the new 
coordinates), the Move Immediately checkbox should be left unchecked. The Move 
button will then be activated and should be clicked on to perform the movement. 

 The stepping of the positions can be controlled by adjusting the Step Size before clicking 
on the small arrows on the right side of the Position field. This enables discreet steps to 
be taken. 

 It is also possible to move the manipulator by selecting one of the Predefined Positions. 
Like before, the movement will occur immediately if the Move Immediately checkbox is 
checked, otherwise the Move button needs to be clicked. 
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12 MONOCHROMATOR 

12.1 Introduction 

This section describes how to operate a monochromator user interface in SES, how to install the 
software and how to test the functionality. Monochromator control requires a general 
monochromator library but also a hardware dependent plug-in library. 

12.2 Installation 

12.2.1 Connecting the Controller 

The PC is preferably connected to the monochromator controller hardware via a standardized 
communication protocol such as USB, RS-232, RS-485, Ethernet or GPIB. The choice depends 
on the type of controller. 

12.2.2 Adding the General Monochromator Library 

The general monochromator library is installed by adding the Monochromator.dll in the list of 

user interfaces under Setup  User Interfaces… from the SES menu bar (see section about 
user interfaces above). 
Once the Monochromator.dll library has been added to the list, the Monochromator menu 
appears on the SES menu bar. 

12.2.3 Adding the Hardware Dependent Plug-in Library 

While the general Monochromator library is a control library for all types of monochromators, 
the hardware dependent plug-in handles the communication with specific hardware. The 
following steps should be taken to install such plug-in. 

1. Select the Monochromator.dll file and click the Setup... button in the User Interfaces 

dialog or select Monochromator  Setup… from the SES menu bar. The Setup 
Monochromator dialog is opened by both actions. 

2. Click the Browse button and select the plug-in dll library. The dialog is shown below 
where the MonoHW_Dummy is given as a plug-in example. 

 

 

Figure 73: The Setup Monochromator dialog. 

3. When Continue Acquisition on Error is checked, the acquisition will continue even when 
the monochromator has stopped due to an error. 

4. When Avoid repeated settings of same Energy is checked, no command is sent to the 
monochromator unless the energy is changed. 
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12.3 Setup 

If the monochromator hardware dependent library has configurable parameters, they can be 
changed from a corresponding setup dialog. 
 

 In the Setup Monochromator dialog, click the Setup... button to open the setup dialog. 

12.4 Operation 

12.4.1 Monochromator Menu 

The Monochromator user interface creates the Monochromator menu on the SES menu bar. 
 

 

Figure 74: The Monochromator Menu. 

 Setup... opens the Setup Monochromator dialog for selection of hardware plug-in 
library and parameter setup. 

 Manual Control... gives access to the Control Monochromator dialog for manual 
change of the photon energy. 

12.4.2 CIS and CFS Run Modes 

Constant Initial State (CIS) spectroscopy is performed by scanning the wavelength of incident 
light (moving the monochromator) along with the detected kinetic energy. That means that the 
Binding energy acquisition mode is employed. 
 
In Constant Final State (CFS) spectroscopy the wavelength is also scanned but the kinetic energy 
is kept constant. That means that the Kinetic energy acquisition mode is employed. 
 
CIS and CFS require that the monochromator.dll is installed as a user interface (see sections 
above) 
 
CIS and CFS should not be run together with Move Monochromator special regions since the 
monochromator is not meant to be controlled from two different sources (global and local 
settings would in such case interfere and cause strange behaviour). 
 
When clicking the Edit button in the Run Mode area of the Sequence Editor when CIS (or CFS) 
is selected, the CIS (or CFS) Editor opens. 
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Figure 75: The CIS Editor. 

 The Photon Energy area of the CIS (and CFS) Editor defines the energy range and step 
lengths of the monochromator scan. 

 
CIS and CFS can also be selected for individual regions but the monochromator scan range 
cannot be set individually (no local parameters are available). If different ranges are needed for 
different regions, the user is recommended to use multiple sequences (see Acquisition tab under 

File  Options…). This allows individual settings for multiple monochromator scans. 

12.4.3 Move Monochromator Special Region 

A Move Monochromator special region is created in the following way: 

1. Make sure that the monochromator user interface is installed successfully. 

2. Select Move Monochromator in the Special Region field of the Sequence Editor 

3. Click the corresponding New button that will add Move Monochromator to the sequence 
list and open the Region Editor. 

4. Fill in the wanted Photon Energy (or select a pre-defined energy from the list) in the 
Region Editor. 

 

 

Figure 76: The Region Editor for the Move Monochromator special region 

When a Move Monochromator special region is defined in the sequence list, the monochromator 
will be set to a specific photon energy when the region is executed along with other types of 
regions in the list. 
 
Note: Move Monochromator special regions cannot be combined with the CIS and CFS run 
modes. That would mix local and global settings and cause strange behaviour. 

12.4.4 Manual Control 

In order to verify that the settings are OK and that the monochromator moves in a controlled 
manner, the Control Monochromator dialog should be used. It is accessed from 

Monochromator  Manual Control… from the SES menu bar. 
 

 

Figure 77: The Control Monochromator dialog 
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 The desired photon energy is entered in the corresponding field and the energy value is 
sent to the monochromator controller when the Set button is pressed. 

 When the Get button is pressed, the current photon energy is read from the 
monochromator controller (if feedback functionality is implemented in the 
software/hardware setup), and viewed in the Indicated Photon Energy field. 
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13 DA30 SOFTWARE PACKAGE 

The DA30 spectrometer requires a set of libraries and configuration files to be installed in SES. 
The features of this software package are described in the DA30 Software User’s Guide 
document. 
 

14 SINGLE TRANSFER SPIN 

The software features of the SpinSwitch plug-in for Single Transfer Spin detectors are described 
in the Single Transfer Spin Software User’s Guide document. 
 

15 LUA SCRIPT PROGRAMMING 

The ScriptTimer plug-in library gives the user an opportunity to design special regions and other 
applications by use of the Lua script language. ScriptTimer includes a timer that can send periodic 
events to Lua for clocked applications. 
The software features for ScriptTimer are described in the ScriptTimer Software User’s Guide 
document. 
ScriptTimer operates together with the ScriptMonitor, ScriptExternalIO, and Serial libraries for 
data presentation and external device communication. 
ScriptMonitor and ScriptExternalIO are described in their own separate User’s Guides. 
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